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ВВЕДЕНИЕ

В соответствии с учебными планами многоуровневого
высшего образования студенты специальностей 160201 –
«Самолето� и вертолетостроение», 160901 – «Техническая
эксплуатация летательных аппаратов и двигателей», а также
070601 – «Дизайн» изучают курс инженерной и компьютер�
ной графики. При изучении этого курса от студентов требует�
ся выполнение графических работ с применением современ�
ных систем автоматизированного проектирования. В качестве
таких используется одна из самых популярных графических
систем автоматизированного проектирования – AutoCAD.

Графическая система AutoCAD разработана фирмой Auto�
Desk (США), предназначена для автоматизации инженерно�
графических работ и поэтому совместно с компьютером пред�
ставляет собой «электронный кульман».

Со времени появления первой версии она превратилась в
мощную среду, без которой трудно представить работу совре�
менного промышленного предприятия или конструкторских
бюро. Новейшая версия, описанная в пособии, – AutoCAD
2007 является результатом ее эволюционного развития. В дан�
ной версии некоторые изменения коснулись среды трехмерно�
го моделирования; улучшен пользовательский интерфейс.

Графическая система AutoCAD 2007 устанавливается в
операционной системе Windows XP с процессором Pentium III
и занимает дисковое пространство порядка 750 Мб.

Данное пособие является переработанным и дополненным
изданием книги: Аббасов И.Б. Чертежи в графической среде
AutoCAD. Учебное пособие. – Таганрог: изд�во ТРТУ, 2002. –
82 с. [1]. Учебно�методический материал, представленный в
пособии, прошел успешную апробацию в течение 7 лет в
Таганрогском государственном радиотехническом университе�
те. В данном издании чертежи выполнены с использованием
новейшей версии программы AutoCAD 2007. В отличие от
предыдущего издания пособие дополнено основами создания
поверхностных и твердотельных моделей.

Введение 5



В данной работе рассматриваются следующие вопросы:

• настройка графической системы AutoCAD 2007 под
конкретного пользователя;

• методика создания, редактирования и оформления
чертежей в соответствии со стандартами ЕСКД,
описывающая технологию выполнения чертежей в дан�
ной системе «от простого к сложному»; 

• варианты индивидуальных графических заданий по
техническому черчению для построения линий пересече�
ния поверхностей;

• поэтапное выполнение индивидуальных заданий в гра�
фической среде AutoCAD 2007 по методике, описанной
в данной работе;

• описание и настройка трехмерного рабочего про)
странства графической системы AutoCAD 2007;

• методы построения трехмерных объектов в виде кар�
касных, поверхностных и твердотельных моделей в гра�
фической среде AutoCAD 2007.

Выполнение индивидуального графического задания состо�
ит из следующих пунктов:

• построение по двум изображениям детали третьего изо)
бражения с рациональными разрезами на формате A3;

• построение линии пересечения и перехода поверхностей;
• проставление размеров и заполнение основной надписи;
• построение твердотельной модели корпусной детали.

В пособии описана методика создания различных трехмер�
ных объектов с помощью средств трехмерного моделирования
графической системы AutoCAD.

1. ЗАПУСК И ОКНО ГРАФИЧЕСКОГО
РЕДАКТОРА AUTOCAD 2007

Графическая система AutoCAD 2007 запускается в опера�
ционной системе Windows XP. После загрузки на экране
появляется диалоговое окно выбора рабочего пространства,
изображенное на рис. 1.1.

Создаем чертежи на компьютере в AutoCAD 2007/20086



В нем можно выбрать интерфейс AutoCAD Classic (Клас�
сический стиль) или 3D Modeling (3М моделирование). Для
начала выберем пункт AutoCAD Classic (Классический
стиль), поскольку начнем с освоения двухмерного простран�
ства.

После этого появится окно, с помощью которого можно
ознакомиться с новыми функциями программы. Выберите в
нем переключатель Yes (Да), Maybe later (Позже) или No,
Don’t me this again (Больше не показывать это окно) и щел�
кните на кнопке OK.

Далее появится диалоговое окно Startup (Начало рабо�
ты). Появление или отсутствие данного диалогового окна
регулируется командой Tools ⇒ Options (Сервис ⇒
Настройки), во вкладке System (Система) раздела General
Options (Общие параметры) в списке Startup (Начало рабо�
ты) выберите Show startup dialog box (Показывать диалого�
вое окно начало работы).

Необходимо также отметить, что по умолчанию рабочая
зона имеет черный цвет. Для удобства рекомендуется изме�

Глава 1. Запуск и окно графичского редактора AutoCAD 2007 7
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нить цвет рабочей зоны с черного на белый (или другой пон�
равившийся вам цвет).

Выберите команду Tools ⇒ Options (Сервис ⇒ Настрой�
ки), во вкладке Display (Экран) щелкните на кнопке Colors
(Цвета). Откроется потом диалоговое окно Drawing Window
Color (Окно цветов чертежа) – рис. 1.2. В данном диалого�
вом окне можно установить цвет для каждого элемента экрана.

Рис. 1.2. Окно выбора цвета рабочей зоны

По умолчанию цвет двухмерной рабочей зоны находится
первым по списку, поэтому в поле Color (Цвет) выберите
строчку White (Белый). Закройте диалоговое окно, щелкнув
на кнопке Apply&Close (Применить и закрыть).

Диалоговое окно Startup (Начало работы) показано на
рис. 1.3.

С помощью диалогового окна Startup (Начало работы)
можно открыть существующий чертеж или создать новый. В
первом случае необходимо щелкнуть по кнопке Open a
Drawing (Открыть чертеж), а во втором – по кнопке Start
from Scratch (Начать с нуля), Use a Template (По шаблону)
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Use a Wizard (Использовать мастера). Это диалоговое окно в
дальнейшем будет появляться также при выполнении коман�
ды File ⇒ New (Файл ⇒ Новый) для создания нового чер�
тежа.

После выбора режима Start from Scratch (Начать с нуля)
и метрической системы единиц AutoCAD откроет рабочий
экран для нового чертежа без предварительных установок.
Прежде чем начать чертить, познакомимся с рабочим окном
(графическим интерфейсом) редактора AutoCAD.

1.1. Рабочий стол пользователя

На рис. 1.4 показано рабочее окно AutoCAD 2007 после
запуска. При этом в строке заголовка (в левом верхнем углу
экрана) появится имя файла, автоматически присвоенное
будущему чертежу, – Drawing 1.

На экране можно выделить четыре функциональные зоны:

• Рабочая графическая зона – это основная область,
находящаяся в середине экрана, где выполняется чер�
теж. В левом нижнем углу зоны находится пиктограмма
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пользовательской системы координат. Направления
стрелок совпадают с положительным направлением
осей.

• Системное меню и панели инструментов. В самом
верху находится строка заголовка, а под ней строка –
системного меню AutoCAD. Ниже размещаются две
строки, занятые панелями инструментов. Слева от рабочей
зоны расположены «плавающие» панели инструментов
Draw (Рисование), Modify (Редактирование), справа –
Dimension (Размеры). Их можно перемещать в любое
место экрана. В AutoCAD имеется также множество
других панелей инструментов, которые будут вызывать�
ся по мере необходимости.

• Командная строка. Под рабочей графической зоной
находится командная строка. Любую команду AutoCAD
можно запустить, набрав ее имя в командной строке.
Если команда запущена посредством пиктограммы пане�
ли инструментов или пункта меню, то в командной стро�
ке отображается реакция системы на соответствующую
команду. Кроме того, все, что вводится с клавиатуры,

Рис. 1.4. Рабочее окно AutoCAD 2007



немедленно отображается в командной строке. Если слу�
чайно вызвана не та команда или необходимо отменить
текущую команду, можно нажать клавишу Esc на кла�
виатуре.

• Строка состояния. В строке состояния отображаются
текущие координаты перекрестия (указателя мыши).
Для понимания базовых характеристик попробуем
вычертить графический примитив в виде отрезка соглас�
но приведенной инструкции.

Упражнение 1.1. Вычерчивание отрезка прямой линии

1. Выбрать пиктограмму Line (Отрезок) на панели
инструментов Draw (Рисование) – рис. 1.5, щелкнув по ней
кнопкой мыши (или ввести через командную строку). В команд�
ной строке при этом появится приглашение на ввод команды:

Command: line Specify first point: (Команда:

Отрезок. Определить первую точку).
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2. Ввести через запятую без пробела координаты X и Y
первой точки отрезка, а затем второй точки:

Command: Line Specify first point: 50,50 Enter

(Команда: Отрезок. Определить первую точку: 50,50

Enter);

Specify next point or [Undo]: 100,150 Enter (Опре�

делить следующую точку или [Отменить]: 100,150 Enter);

Specify next point or [Undo]: Enter (Определить

следующую точку или [Отменить]: Enter).

Упражнение 1.2. Стирание отрезка

1. Указать на построенный отрезок, то есть установить
прицел перекрестия (маркер) на отрезке и щелкнуть
левой кнопкой мыши. При этом отрезок выделится
пунктиром, и на его концах появятся «ручки».

2. Нажать клавишу Delete на клавиатуре или указать
мышью на пиктограмму Erase (Стереть) на панели
инструментов Modify (Редактирование). Отрезок будет
удален.

AutoCAD позволяет отменить любую выполненную коман�
ду или группу команд. Для того чтобы восстановить изобра�
жение после нежелательного его удаления, достаточно в верх�
ней строке панели инструментов (рис. 1.5) щелкнуть мышью
по пиктограмме левой стрелки Undo (Отмена).

Динамический режим ввода

Необходимо подчеркнуть, что в AutoCAD 2007 существует
режим динамического ввода данных. Режим динамического
ввода Dynamic Input (Динамический ввод) включается нажа�
тием кнопки DYN (ДИН) в строке состояния (рис. 1.6).

При выполнении описанной выше команды в динамиче�
ском режиме рядом с курсором появится строка подсказок
(рис. 1.6). В ней отображается запрос команды на ввод коорди�
нат точки. С появлением режима динамического ввода (с вер�
сии AutoCAD 2006) панель координат в нижнем левом углу
рабочего окна редактора (см. рис. 1.4) утратила свою значи�
мость, так как в ней повторяется та же информация.
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Режим динамического ввода имеет две разновидности:
Pointer Input (задание точки ее координатами) и Dimension
Input (задание точки расстоянием и углом). Настройка этих
режимов осуществляется с помощью диалогового окна Tools ⇒
Drafting Settings (Инструменты ⇒ Пapаметры привязки).

В дальнейшем мы будем работать в классическом режиме
ввода, поэтому режим динамического ввода пока можно
отключить отжатием кнопки DYN (ДИН) в строке состояния.

Упражнение 1.3. Сохранение чертежа

1. Щелкнуть по меню File (Файл) в верхней строке пане�
ли инструментов, выбрать из выпадающего списка Save
Drawing As (Сохранить как). На экране появится диа�
логовое окно Save Drawing As с перечнем папок на
выбранном диске.

2. Вызвать или создать новую папку. В строке File Name
(Имя файла) введите имя чертежа – Чертеж 1 и щел�
кните по кнопке Save (Сохранить) данного окна. Всем
создаваемым в AutoCAD файлам чертежей автоматиче�
ски присваивается расширение .dwg.

Выход из системы

Для выхода из системы можно использовать одно из сле�
дующих действий:
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• щелкнуть мышью по кнопке Close (Закрыть) – крестик
в правом верхнем углу экрана;

• набрать в командной строке слово Quit и нажать клави�
шу Enter;

• выбрать в меню File ⇒ Exit (Файл ⇒ Выход).

Если информация в чертеже не была сохранена, то Auto�
CAD предложит ее сохранить. Можно принять это предложе�
ние, ответив Yes (Да), можно выйти из системы без сохране�
ния последних изменений, ответив No (Нет), или отказаться
от выхода и вернуться к чертежу, нажав кнопку Cancel
(Отмена).

1.2. Меню и панели инструментов

Вызов команд AutoCAD осуществляется из меню или при
помощи пиктограмм панелей инструментов. Строка системно�
го меню в версии AutoCAD 2007 состоит из следующих выпа�
дающих меню [2]:

• File (Файл) – меню предназначено для открытия, сох�
ранения, печати, экспорта в другие форматы файлов
(чертежей) и выхода из системы;

• Edit (Правка) – меню редактирования частей чертежа в
рабочей зоне;

• View (Вид) – меню управления экраном, переключения
режимов пространства листа и модели, установки точки
зрения для трехмерных моделей, тонирования, управле�
ния параметрами дисплея;

• Insert (Вставить) – меню команд вставки блоков и
объектов из других приложений;

• Format (Формат) – меню установки границ чертежа и
единиц измерений, управления стилем текста, размера�
ми, работы со слоями, цветом, типом и толщиной линий;

• Tools (Инструменты) – меню средств управления систе�
мой, установки параметров черчения, привязок и поль�
зовательской системы координат;

• Draw (Черчение) – меню построения графических при�
митивов и трехмерных моделей;
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• Dimension (Размер) – меню команд нанесения разме�
ров;

• Modify (Редактирование) – меню редактирования гра�
фических объектов;

• Window (Окно) – меню управления и сортировки
открытых чертежей (файлов);

• Help (Справка) – меню справки.

На рис. 1.7а в качестве примера изображена часть выпа�
дающего меню Draw (Черчение). Чтобы увидеть его на экра�
не, следует указать курсором на слово Draw системного меню
и щелкнуть мышью. Также можно выводить на экран подме�
ню, если справа находится черный треугольник.

Контекстные меню

Контекстные меню обеспечивают быстрый доступ к списку
опций для текущей команды. Контекстные меню открываются
после нажатия правой кнопки мыши. На рис.1.7б приведено
контекстное меню по умолчанию, которое открывается после
нажатия правой кнопкой мыши в области чертежа.
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Рис. 1.7. Меню Draw (Черчение) и контекстные меню



Контекстное меню режима редактирования открывается
после выбора какого�либо объекта (например, построенного
отрезка – рис. 1.7в) и нажатия правой кнопки мыши.

Панели инструментов

Панели инструментов позволяют выполнять команды Auto�
CAD простым щелчком мыши на выбранной пиктограмме.
Панели инструментов могут быть плавающими или с фикси�
рованным месторасположением. В AutoCAD 2007 существует
около 40 панелей инструментов.

Упражнение 1.4. Вызов панели инструментов

1. Выбрать из системного меню View ⇒ Toolbars (Вид ⇒
Панели инструментов).

2. В появившемся диалоговом окне Customize User Inter�
face (Настройка интерфейса пользователя) в строке
Toolbars (Панели инструментов) можно выбрать любую
панель инструментов.

3. Для появления на рабочем столе линейки с пиктограм�
мами масштабирования экрана можно щелкнуть правой
кнопкой по любой пиктограмме панели инструментов и
в конце списка контектного меню выбрать строчку Zoom
(Масштаб) – рис. 1.8.

Рис. 1.8. Пиктограммы меню масштабирования экрана

1.3. Настройка AutoCAD для индивидуального
пользователя

Перед тем как начать работу над новым чертежом, необходи�
мо настроить рабочую среду, то есть задать размеры рабочего
поля чертежа, единицы измерения, установить систему координат
и т.д. Для этого в AutoCAD 2007 существует мастер настройки
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рабочей среды, который открывается сразу же после загрузки
системы (окно Startup (Начало работы)). В верхней части диало�
гового окна Startup (рис.1.3) расположены четыре строчки:

• Open a Drawing (Открыть чертеж) – открыть суще�
ствующий файл чертежа;

• Start from Scratch (Начать с нуля) – создать новый
чертеж с параметрами, которые AutoCAD устанавлива�
ет по умолчанию;

• Use a Template (Использовать шаблон) – установить в
новом чертеже параметры из ранее созданных шаблонов;

• Use a Wizard (Использовать мастер) – запустить поша�
говый процесс установки параметров нового чертежа,
при этом возможны два варианта настройки: деталь�
ная – Advanced Setup и быстрая – Quick Setup.

Упражнение 1.5. Настройка параметров рабочей среды

Диалоговое окно мастера (рис. 1.9) содержит эти два режи�
ма настройки параметров рабочей среды. Быстрая настройка
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Рис. 1.9. Диалоговое окно мастера установки параметров 

рабочей среды
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параметров состоит из двух этапов. Она позволяет только
задавать пределы чертежа и единицы измерения расстояний.

Мы начнем с детальной настройки Advanced Setup (Деталь�
ная настройка) параметров рабочей среды. Детальная
настройка содержит пять этапов.

Установить следующие параметры рабочей среды:

• тип единиц измерения линейных величин Units и их
точность Precision – выбрать систему Decimal (Деся�
тичные) и точность до десятой части, нажать кнопку
Next (Далее) (после каждой установки);

• форматы представления угловых величин Angle и их
точность – выбрать десятичную систему;

• базу для отсчета угловых величин – установить East
(Восток);

• направление отсчета угловых величин – выбрать напра�
вление против часовой стрелки;

• пределы рабочего поля чертежа – выбрать размеры
формата A4 (210х297мм – рис. 1.10), далее для выхода
из диалогового окна нажать на кнопку Finish (Готово).

Рис.1.10. Диалоговое окно установки размеров поля чертежа



Следует отметить, что размеры формата можно установить
также через команду Format ⇒ Drawing Limits (Формат ⇒
Границы чертежа).

1.4. Системы координат

В системе AutoCAD создание любого графического прими�
тива основано на задании последовательности точек. Коорди�
наты точек могут вводиться в виде абсолютных и относитель�
ных координат.

Ввод абсолютных координат осуществляется в двух форматах:

• прямоугольных (декартовых) координат (X, Y);
• полярных координат (r < A, где r – радиус, а А – угол,

заданный в градусах против часовой стрелки).

Относительные координаты задают смещение по осям X и
Y от последней введенной точки. Ввод относительных коорди�
нат осуществляется аналогично вводу абсолютных координат,
но перед ними ставится знак @ (@dx,dy – для прямоугольной
системы, @r<A – для полярной). Текущие координаты курсо�
ра мыши отображаются в строке состояния в панели коорди�
нат (левый нижний угол экрана).

В полярном режиме линии проводятся под различными
углами, в ортогональном режиме линии проводятся только
вдоль осей координат. Переключение режимов осуществляет�
ся щелчком мыши по командным кнопкам ORTHO (ОРТО) и
POLAR (ПОЛЯРНЫЙ) в строке состояния.

Упражнение 1.6. Вычерчивание ромба

1. Открыть файл «Чертеж 1» (если он был закрыт).
Выбрать пиктограмму Line (Отрезок) на панели инстру�
ментов Draw (Рисование) – рис. 1.5, щелкнув по ней
кнопкой мыши. В командной строке при этом появится
приглашение на ввод команды: Command: line Speci�
fy first point: (Команда: Отрезок. Определить

первую точку:).
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2. Далее ввести с клавиатуры без пробела координаты X и
Y вершин ромба согласно листингу командной строки на
рис. 1.11.

Привязка координат

Для точного ввода координат точек при помощи мыши в
AutoCAD имеются специальные команды:

• шаговая привязка SNAP (ПРИВ) – режим привязки
координат точек к узлам воображаемой сетки (сетку
можно сделать видимой при помощи кнопки GRID
(СЕТКА) в командной строке), в этом режиме курсор
мыши будет перемещаться только по узлам сетки;

• объектная привязка OSNAP (ОПРИВ) – режим при�
вязки координат к различным точкам уже созданных
объектов.

Включать или отключать эти режимы можно с помощью
соответствующих кнопок строки состояния. Регулировать
характеристики привязок можно в диалоговом окне Tools ⇒

Рис. 1.11. Вычерчивание ромба
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Рис. 1.12. Диалоговое окно Drafting Settings (Параметры привязки),

закладка Snap and Grid (Привязка и сетка)

Рис. 1.13. Диалоговое окно Drafting Settings (Параметры привязки),

закладка Object Snap (Объектная привязка)



Drafting Settings (Сервис ⇒ Параметры привязки), устано�
вив соответствующую закладку:

• Snap and Grid (Привязка и сетка) – для установки
параметров привязки и сетки (рис. 1.12);

• Object Snap (Объектная привязка) – для установки
параметров объектной привязки (рис. 1.13).

Для вызова диалогового окна следует выбрать из меню
Tools ⇒ Drafting Settings (Инструменты ⇒ Пapаметры при�
вязки).

1.5. Управление экраном

Для удобства работы с элементами чертежа в AutoCAD
предусмотрены различные команды управления изображени�
ем на экране. Все они находятся в меню View (Вид). Коман�
да Zoom (Масштаб) управляет масштабом изображения на
экране. При увеличении масштаба все элементы на экране
увеличиваются, как бы приближаясь к пользователю. При
последовательном уменьшении масштаба в поле изображения
попадает все большая часть чертежа. Вызвать опции команды
Zoom (Масштаб) можно при помощи пиктограмм на стандарт�
ной панели инструментов (см. рис. 1.8). Ниже приведены
основные опции этой команды:

– Zoom Window (Увеличить до окна). Опция позво�
ляет задать при помощи рамки границы масштаби�
руемого изображения;

– Zoom In (Увеличить). Опция увеличивает изобра�
жение в два раза после каждого щелчка мыши на
пиктограмме;

– Zoom Out (Уменьшить). Опция уменьшает изо�
бражение в два раза после каждого щелчка мыши
на пиктограмме;

– Zoom All (Показать все). Опция масштабирует
изображение таким образом, чтобы пределы черте�
жа совпали с графической зоной экрана;

– Zoom Extents (Показать все объекты). Опция
позволяет показать все имеющиеся на чертеже гра�
фические элементы;
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– Zoom Preview (Предыдущий масштаб). Опция
восстанавливает предыдущие параметры масшта�
бирования;

– Zoom Realtime (Масштаб в реальном времени).
Опция управляет масштабом изображения на
экране;

– Pan Realtime (Перемещение в реальном времени).
Опция управляет панорамированием.

Команда View ⇒ Redraw (Вид ⇒ Перерисовать все) позво�
ляет перерисовывать на экране изображение, которое по мере
работы с чертежом «засоряется» временными маркерами, и
тем самым дает возможность его очистить.

2. ГРАФИЧЕСКИЕ ПРИМИТИВЫ

В системе AutoCAD любое изображение создается с помо�
щью базового набора двухмерных примитивов. Команды для их
рисования находятся в подменю Draw (Черчение) основного
меню. Однако проще всего вызвать команду создания графиче�
ского примитива при помощи пиктограммы панели инструмен�
тов Draw (Черчение). Если эта панель отсутствует, ее можно
вызвать, щелкнув правой кнопкой мыши на любой пиктограмме
панели инструментов. При этом на экране появится контекстное
меню, из которого необходимо выбрать строку Draw.

2.1. Свойства примитивов

Любой графический примитив может быть нарисован на
определенном слое чертежа линиями определенного типа, тол�
щины и цвета. Инструменты для задания этих свойств находят�
ся в панелях Layers (Слои) и Properties (Свойства) – рис. 2.1.
Включать или отключать отображение толщины линии на
экране можно кнопкой LWT (ТОЛЩ) в строке состояния.
После загрузки системы для всех примитивов автоматически
устанавливается нулевой слой, на котором примитивы будут
иметь черный цвет, основной тип линий Continuous (Сплош�
ная) и определенную толщину Default (По умолчанию). На
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пиктограммах цвета, типа и толщины линий панели инстру�
ментов Properties (Свойства) устанавливается строка ByLay�
er (По слою), что означает соответствие их установкам теку�
щего нулевого слоя.

Установка цвета, толщины и типа линий

Изменять цвет и толщину линий примитивов можно, просто
используя соответствующие списки этих инструментов. Списки
раскрываются при щелчке левой кнопкой мыши по стрелке
пиктограммы инструмента Lineweight Control (Выбор толщи�
ны линии). В раскрытом списке (рис. 2.2) нужно сделать соот�
ветствующий выбор цвета, типа и толщины линий.

Для изменения типа линий необходимо щелкнуть на стрел�
ке инструмента Linetype Control (Выбор толщины линии) и

Рис. 2.1. Панели инструментов Layers (Слои) и Properties (Свойства)

Рис. 2.2. Выбор цвета, толщины и типа линий



выбрать из списка Other… (Другое…) – рис. 2.2. В появив�
шемся диалоговом окне Linetype Manager (Мастер типов
линий) щелкнуть по клавише Load... (Загрузить...). В диало�
говом окне Load or Reload Linetypes (Загрузить или обновить
типы линий) выбрать нужный тип линии и щелкнуть на кноп�
ке ОК диалоговых окон. В результате в списке инструмента
Linetype Control (Выбор типа линии) появятся новые типы
линий (в данном случае штрихпунктирная осевая линия).

2.2. Геометрические элементы для черчения

Любой чертеж состоит из отрезков прямых и дуг кривых
линий. Для вычерчивания прямолинейных участков чертежа
служат инструменты Line (Линия), Constraction Line (Кон�
струкционная линия), Polyline (Ломаная), Polygon (Много�
угольник), Rectangle (Прямоугольник), Point (Точка). Кри�
волинейные участки создаются инструментами Arc (Дуга),
Circle (Окружность), Spline (Сплайн), Ellipse (Эллипс).

Опишем команды рисования примитивов по пиктограммам
(слева направо) на панели инструментов Draw (Черчение).

Команда Line

Команда Line (Линия) имеет две опции, которые
можно выбирать из контекстного меню команды в про�
цессе построения сегментов линии или введением
заглавной буквы с клавиатуры:

• Undo (Вернуться) – стирает последний сформирован�
ный сегмент ломаной без завершения команды;

• Close (Замкнуть) – автоматически проводит последний
сегмент, замыкая линию.

Команда Constraction Line

Команда Constraction Line (Конструкционная линия)
служит для проведения вспомогательных линий, кото�
рые могут использоваться, в качестве линий связи
между проекциями детали. Отличие этого примитива
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от простой линии в том, что она продлевается автоматически
в обе стороны до границ экрана независимо от масштаба изо�
бражения. Команда Constraction Line (Конструкционная
линия) имеет пять опций:

• Hor, Ver – для построения горизонтальных и верти�
кальных линий;

• Ang – для построения наклонных линий под определен�
ным углом;

• Bisect – для построения биссектрисы угла по его вер�
шине и двум точкам, расположенным на сторонах угла;

• Offset – для построения прямой параллельно любому
указанному отрезку на заданном расстоянии или через
указанную точку.

Следует отметить, что команда Constraction Line (Кон�
струкционная линия) в AutoCAD 2000 утратила свою значи�
мость, так как в новой версии появилась функция отслежива�
ния при объектной привязке, позволяющая генерировать вре�
менные вспомогательные линии взамен реальных геометриче�
ских построений.

Команда Polyline

Команда Polyline (Ломаная) позволяет строить после�
довательность прямолинейных и криволинейных сег�
ментов. На прямолинейных участках команда позволя�

ет менять ширину как при переходе от одного сегмента к дру�
гому, так и в пределах одного сегмента. Команда имеет шесть
опций:

• Halfwidth (Полуширина) – позволяет задать полушири�
ну сегмента;

• Width (Ширина) – позволяет задать ширину последую�
щего сегмента;

• Undo (Отмена) – отменяет последний созданный сегмент;
• Arc (Дуга) – переводит команду в режим вычерчивания

дуг;
• Close (Замкнуть) – замыкает линию отрезком;
• Length (Длина) – определяет следующий прямолиней�

ный сегмент в том же направлении, что и предыдущий.
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Команда Polygon

Команда Polygon (Многоугольник) строит правиль�
ный многоугольник с количеством сторон от 3 до 1024.
После вызова команды в ответ на запрос системы сле�

дует ввести количество сторон многоугольника. Затем необхо�
димо выбрать один из трех методов задания многоугольника,
которым соответствуют опции команды:

• Edge (Сторона) – определяет положение любого ребра
многоугольника по двум заданным точкам;

• Inscribed in circle (Вписанный в окружность) – форми�
рует по заданным центру и радиусу воображаемую
окружность, в которую будет вписан многоугольник;

• Circumscribed (Описанный вокруг окружности) – форми�
рует по заданным центру и радиусу воображаемую окруж�
ность, вокруг которой будет описан многоугольник.

Две последние опции появляются после указания центра
окружности.

Команда Rectangle

Команда Rectangle (Прямоугольник) позволяет стро�
ить прямоугольник по двум противолежащим верши�
нам. Для задания вершин можно использовать любой

способ ввода координат. Прямоугольник можно задавать с
фасками и со скругленными краями, используя следующие
опции:

• Chamfer (Фаска) – формирует скосы по углам при зада�
нии расстояний от вершины до скоса вдоль обеих сторон;

• Fillet (Скругление) – формирует скругление углов при
введении значения радиуса сопряжения.

Команда Arc

Команда Arc (Дуга) позволяет вычертить дугу окруж�
ности. В AutoCAD существуют разные способы зада�
ния дуги. Например, дугу можно задать:
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• начальной точкой, центром и конечной точкой;
• начальной точкой, конечной точкой и радиусом;
• центром, начальной точкой и длиной хорды и т.д.

Соответствующая опция выбирается из команды Arc
(Дуга) подменю Draw (Черчение). Следует отметить, что дуги
строятся из начальной точки против часовой стрелки.

Команда Circle

Команда Circle (Окружность) позволяет вычертить
окружность одним из шести способов:

• по центру окружности и ее радиусу – опции Center,
Radius (Центр, радиус);

• по центру окружности и ее диаметру – опции Center,
Diameter (Центр, диаметр);

• по двум точкам диаметра окружности – опции 2 Points
(2 точки);

• по трем точкам окружности – опции 3 Points (3 точки);
• по двум касательным (двум отрезкам, отрезку и окруж�

ности и т.д.) и радиусу – опции Tan, Tan, Radius
(Касательная, касательная, радиус);

• по трем касательным – опции Tan, Tan, Tan (Касатель�
ная, касательная, касательная).

Опции команды выбираются из команды Circle (Окруж�
ность) подменю Draw (Черчение) или в процессе диалога из
контекстного меню команды.

Команда Revision Cloud

Команда Revision Cloud (Облако) позволяет выделить
на чертеже необходимые области для пометок тремя
способами:

• Arc length (Длина дуги) – задает длину дуги в облаке;
• Object (Объект) – превращает в облако текущий

объект;
• Style (Стиль) – задает стиль начертания облака: нор�

мальный или каллиграфический.
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Команда Spline

Команда Spline (Сплайн) позволяет провести на черте�
же волнистую линию произвольной формы в виде кри�
вых Безье. Сплайн строится по точкам, которые после�

довательно вводятся после вызова команды и управляются
касательными.

Команда Ellipse

Команда Ellipse (Эллипс) позволяет вычертить как
полный эллипс, так и его часть. Основными параме�
трами эллипса являются координаты центра, направле�

ние и размер большой и малой осей. Полный эллипс можно
вычертить двумя способами:

• определить центр эллипса, а затем остальные параме�
тры – выбор опции Center (Центр);

• определить конечные точки осей эллипса – выбор опции
Axis, End (Ось, конец).

Для построения части эллипса нужно выбрать опцию Arc
(Дуга).

Команда Ellipse Arc

Команда Ellipse Arc (Эллиптическая дуга) позволяет
вычертить дугу эллипса произвольной протяженности.
При этом задаются как основные параметры исходно�

го эллипса, так и начальная и конечная точки.

Команды Insert Block и Make Block

Команды Insert Block (Вставка блока) и Make
Block (Создать блок) позволяют вставлять и созда�
вать блоки. Блок – это группа объектов, объединен�

ных в единый объект. В блоки могут входить геометрические
примитивы. Блоки можно многократно вставлять в чертеж,
поворачивать или масштабировать, сохраняя при этом исход�
ные свойства объектов в блоке.
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Команда Point

Команда Point (Точка) позволяет создавать метки раз�
ных видов. Точки являются объектами и выводятся на
печать. Форма и размер точки определяется командой
Format ⇒ Poin Style (Формат ⇒ Стиль точки).

Команды Hatch и Gradient

Команды Hatch (Штриховка) и Gradient (Гради�
ент) позволяют заштриховать фигуры сечения и
заливать замкнутые контуры выбранной градиент�
ной заливкой.

Команды Table и Multiline Text

Команды Table (Таблица) и Multiline Text (Многос�
трочный текст) позволяют создавать таблицы и тек�
стовые надписи на чертежах.

Перед началом упражнений по вычерчиванию различных
примитивов познакомимся с командами удаления и восстано�
вления изображения, так как без этих команд не обходится ни
один процесс построения чертежа.

3. РЕДАКТИРОВАНИЕ ЧЕРТЕЖА

3.1. Удаление примитивов

Для удаления объекта достаточно щелкнуть по пикто�
грамме Erase (Удалить) панели инструментов Modify
(Редактирование) и выбрать удаляемое или просто

нажать клавишу Delete на клавиатуре. Для выбора несколь�
ких объектов можно указывать на них последовательно
мышью. Объекты также можно выбирать и при помощи рамки
(прямоугольника) протягиванием мыши по экрану.
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Отмена предыдущих команд

Для отмены одной последней команды нужно щелкнуть по
пиктограмме Undo (Отмена) на стандартной панели инстру�
ментов. После каждого щелчка по пиктограмме будет
отменяться последняя команда в списке выполненных.
Команда Redo (Вернуть) восстанавливает все отмены
команды Undo, если последняя была введена с клавиа�
туры. Если же команда Undo вызывалась при помощи

стрелки стандартной панели инструментов несколько раз, то коман�
да Redo восстановит лишь последнюю отмененную команду.

Для восстановления изображения на экране существует
еще команда oops (ой). Она действует только по отношению
к самой последней команде стирания графического объекта.

Упражнение 3.1. Построение рамки формата A4
Выполнить построения в соответствии с рис. 3.1.
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Рис. 3.1. Вычерчивание рамки формата A4 и элементов чертежа



Создаем чертежи на компьютере в AutoCAD 2007/200832

1. Открыть файл «Чертеж 1» (формат A4), удалить
построения с помощью инструмента Erase (Удалить)
или клавиши Delete.

2. Вычертить рамку формата (210х297 мм), используя
команду Line (Линия), координаты точек задавать в
соответствии с листингом (рис. 3.2) [3]. 

3. Далее установить толщину линии 0,3 мм и начертить рамку
чертежа, используя команду Rectangle (Прямоугольник).

4. Провести горизонтальную прямую с координатами
точек: левая – X=20, Y=60; правая – X=205, Y=60.

5. Вычертить шестиугольник в верхней правой части поля
чертежа, описанный вокруг окружности с радиусом
15 мм, используя команду Polygon (Многоугольник)
(в соответствии с листингом на рис. 3.3).

6. Построить замкнутый контур, используя команды Line
(Линия) и Arc (Дуга), в соответствии с рис. 3.1:
� ориентируясь по шагу сетки, начертить прямую 1,

используя команду Line (Линия) и привязку к узлам
сетки (кнопки SNAP (ПРИВ) и GRID (СЕТКА)
строки состояния);

� выбрать Draw ⇒ Arc ⇒ Continue (Черчение ⇒
Дуга ⇒ Продолжить) и начертить дугу 2 окружности
радиусом 30 мм;

� провести прямую 3 симметрично прямой 1;

Рис. 3.2. Листинг команд Line (Линия) 

и Rectangle (Прямоугольник)



� замкнуть контур прямой линией, используя команду
Line (Линия);

� построить осевую линию, выбрав соответствующий
тип линии.

7. Сохранить построения с использованием команды
File ⇒ Save As (Файл ⇒ Сохранить как) под названи�
ем «Чертеж 1». На запрос Do you want to replase it?
(Хотите ли Вы заменить?) нажать кнопку Да.

3.2. Геометрические построения
с использованием объектных привязок

Точный ввод координат точек геометрических примитивов
не всегда удобно осуществлять с клавиатуры или при помощи
привязки точек к узлам сетки. В таких случаях используется
объектная привязка. Объектную привязку можно использо�
вать в любом случае, когда AutoCAD запрашивает точку
(начальную, конечную, центр окружности и т.д.). К экранно�
му перекрестию в этом случае добавляется специальный сим�
вол – мишень.

Включать или отключать объектную привязку можно при
помощи кнопки OSNAP (ОПРИВ) строки состояния, а уста�
навливать ту или иную объектную привязку можно при помощи
вкладки Object Snap (Объектная привязка) (см. рис. 1.13)
в диалоговом окне Tools ⇒ Drafting Settings (Сервис ⇒
Параметры привязки). Вызвать панель инструментов Object
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Рис. 3.3. Листинг команды Polygon (Многоугольник)

Рис. 3.4. Панель инструментов Object Snap (Объектная привязка)



Snap (Объектная привязка) (рис.3.4) можно, щелкнув правой
кнопкой по любой пиктограмме панелей инструментов.

При необходимости можно включать сразу несколько при�
вязок, которые используются наиболее часто. Всего в Auto�
CAD 2007 существует 13 объектных привязок:

• Endpoint (Конец) – привязка к ближайшей конечной
точке линии или дуги;

• Midpoint (Середина) – к средней точке линии или дуги;
• Center (Центр) – к центру окружности, дуги или эллипса;
• Node (Узел) – привязка к точечному элементу;
• Quadrant (Квадрант) – привязка к ближайшей точке

квадранта на дуге, окружности или эллипса (0°, 90°,
180°, 270°);

• Intersection (Пересечение) – к пересечению двух объектов;
• Extension (Продолжение) – привязка к продолжению

линии или дуги;
• Insertion (Вставка) – привязка к точке вставки текста, блока;
• Perpendicular (Перпендикуляр) – привязка к точке на

линии или дуге, которая образует совместно с последней
точкой нормаль к этому объекту;

• Tangent (Касательная) – привязка к точке на окружно�
сти или дуге, которая образует касательную при соеди�
нении с последней точкой;

• Nearest (Ближайшее) – привязка к точке на окружности
или дуге, которая является ближайшей к перекрестию;

• Apparent insertion (Мнимое пересечение) – привязка к
точке предполагаемого пересечения (ищет точку «пере�
сечения» двух объектов, которые не имеют явной точки
пересечения в пространстве – скрещивающиеся прямые, –
а имеют лишь видимую на экране точку пересечения);

• Parallel (Параллель) – позволяет проводить линию
параллельно ранее начерченной.

Кроме перечисленных, существует еще функция отслежива�
ния Auto Track (Автоматическое отслеживание), которая включает
две опции: полярное отслеживание и отслеживание при объект�
ной привязке. Когда включен режим автоматического отслежива�
ния Auto Track (кнопка OTRACK (ОСЛЕЖ) в строке состоя�
ния), система генерирует временные вспомогательные линии, что
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обеспечивает создание объектов в точных положениях и под точ�
ными углами и значительно экономит время создания чертежа.

Упражнение 3.2. Построение вторых проекций

Выполнить построения в соответствии с рис. 3.5:

1. Открыть файл «Чертеж 1» и сразу, не выполняя каких�
либо действий, сохранить его под именем «Чертеж 2».
При этом первоначальные построения будут храниться в
файле «Чертеж 1» и к ним всегда можно будет вернуть�
ся в случае потери текущей информации.

2. Вызвать диалоговое окно настройки привязок, щелкнув
правой кнопкой мыши по кнопке OSNAP (ОПРИВ).
Установить привязки Endpoint (Конец), Midpoint
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Рис. 3.5. Вычерчивание элементов чертежа 

с использованием объектной привязки



Создаем чертежи на компьютере в AutoCAD 2007/200836

(Середина), Center (Центр), Quadrant (Квадрант),
Intersection (Пересечение).

3. Включить в строке состояния режим слежения при
объектной привязке, нажав кнопку OTRACK
(ОСЛЕЖ), и отключить режим привязки к сетке, отжав
кнопку SNAP (ПРИВ).

4. Вычертить окружность, центр которой совпадает с цен�
тром дуги:
� вызвать команду Circle (Окружность);
� подвести курсор примерно к центру большой дуги и

при появлении надписи Center (Центр) щелкнуть
левой кнопкой мыши, определив тем самым центр
окружности точно в центре большой дуги;

� ввести с клавиатуры радиус окружности 15 мм.
5. Выполнить изображение над шестиугольником:

� вызвать команду Rectangle (Прямоугольник);
� на запрос команды о первой точке прямоугольника

подвести курсор к левой крайней точке шестиуголь�
ника (рис. 3.6а) и при появлении надписи Endpoint

Рис. 3.6. Вычерчивание прямоугольника 

с использованием объектной привязки



(Конечная точка) нажать на левую кнопку мыши и
потянуть курсор мыши вниз по диагонали (рис. 3.6б).
Зафиксировать потом вторую точку прямоугольника
согласно рис. 3.6б. Вызвать команду Line (Линия) и
построить вертикальные прямые (ребра шестигранни�
ка) в прямоугольнике (рис. 3.7а).

6. Вписать окружность в шестиугольник:
� вызвать команду Circle (Окружность);
� на запрос о центре окружности указать (не нажимая

на кнопку мыши) точку на пересечении линий слеже�
ния от конечной точки (угла) и середины стороны
шестиугольника (вводить точку, то есть щелкнуть
мышью, нужно при появлении соответствующей над�
писи);

� на запрос о радиусе окружности подвести курсор к
любой стороне шестиугольника и при появлении под�
сказки Midpoint (Средняя точка) (рис. 3.7б) щел�
кнуть левой кнопкой мыши.

7. Построить осевые линии окружности (рис. 3.5):
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Рис. 3.7. Вычерчивание ребер шестигранника 

с использованием объектной привязки



� выбрать в списке инструментов Linetype Control
(Выбор типа линии) штрих�пунктирную линию (если
нет в списке, то нужно загрузить ее согласно рис. 2.2
(ISO dash dot);

� выбрать соответствующую толщину линии 0,2 мм в
списке инструментов Lineweight Control (Выбор тол�
щины линии) – рис. 2.2;

� вызвать команду Line (Линия) и определить началь�
ную точку в соответствии с рис. 3.5 (линию слежения
тянуть от центра окружности). Для определения
конечной точки потянуть курсор вниз и щелкнуть
мышью за пределами изображения окружности;

� далее построить осевые линии для проекций шести�
гранника.

8. Аналогично п. 5 построить изображение второй проек�
ции (вид спереди) детали, показанной на рис. 3.5, –
прямоугольник, вертикальные линии которого находят�
ся в проекционной связи с соответствующими крайними
точками окружности, а также дуги и прямой линии.
Затем провести осевые линии.

9. Построить параллелограмм с острыми углами 60° (рис.
3.8):
� вызвать диалоговое окно настройки привязок и уста�

новить привязку Parallel (Параллель), а привязки
Midpoint (Середина), Center (Центр), Quadrant
(Квадрант), Intersection (Пересечение) можно
отключить;

� вызвать команду Line (Линия), на запрос о вводе
первой точки щелкнуть мышью на месте экрана
согласно рис. 3.5, а на запрос о второй точке ввести
ее полярные координаты в относительном формате
@40<120;

� переместить указатель вправо, введя длину отрезка
@40<60;

� продолжить линию параллельно первому отрезку,
указав на него (не нажимая на кнопку мыши) и дож�
давшись появления подсказки Parallel (Параллельно);

� указать на конечную точку первого отрезка (вторая
построенная точка параллелограмма), которая опре�
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деляется после появления двух линий слежения и
соответствующей надписи (рис. 3.8а) в месте их пере�
сечения, после чего зафиксировать результат, щел�
кнув левой кнопкой мыши; далее, достроив четвер�
тую сторону, замкнуть построения.

10. Вычертить перпендикуляр к стороне параллелограмма
(рис. 3.8б):
� вызвать диалоговое окно настройки привязок и уста�

новить привязку Perpendicular (Перпендикуляр);
� установить толщину линии 0,2 мм в списке инстру�

ментов Lineweight Control (Выбор толщины линии);
� вызвать команду Line (Линия);
� первую точку определить произвольно, а вторую –

с помощью подсказки Perpendicular (Перпендику�
ляр), указав на наклонную линию параллелограмма
(рис. 3.8б); зафиксировать точку мышью.

11. Сохранить чертеж.

3.3. Слои

Каждому примитиву присущи такие свойства, как тип
линии, толщина линии и слой, на котором примитив располо�
жен. В ходе построения можно устанавливать эти свойства
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перед созданием примитивов. При вычерчивании сложной
детали с большим количеством контурных, осевых линий,
размеров, штриховки и т.п. удобно выполнять отдельные
элементы чертежа на различных слоях.

Изначально при загрузке системы устанавливается один
нулевой слой (системный), на котором чертить не рекоменду)
ется. Независимо от сложности чертежа, лучше создать хотя
бы один новый слой со своими параметрами, сделать его теку�
щим и чертить на нем. Создать новые слои можно в диалого�
вом окне Layer Properties Manager (Настройка свойств
слоя) – рис. 3.9, которое вызывается из меню Format ⇒
Layer... (Формат ⇒ Слои...) или щелчком по соответствую�
щей кнопке панели инструментов Layers (Слои) – см.
рис. 2.1.

Для создания нового слоя нужно щелкнуть на кнопке New
Layer (Создать) или нажать сочетание клавиш Alt+N. При
этом в новом окне появится выделенная строка, в которой
отражаются установленные по умолчанию параметры нового
слоя:

• Set (Статус) – отображается статус элемента списка.
Используемым слоям соответствует значок в виде листа
бумаги голубого цвета, пустым – серого цвета, текущий
слой отображается в виде галочки;

• Name (Имя) – имя слоя. По умолчанию присваивается
имя «Layer 1» («Слой 1»);

• On (Вкл) – видимость слоя. Вычерчиваются только те
примитивы, которые находятся на видимых слоях (�
когда лампочка «горит»); чтобы сделать слой невиди�
мым, нужно щелкнуть по изображению лампочки
мышью (лампочка темнеет);

• Freeze (Заморозить для всех сечений) – замораживание
слоя. Отключается генерация (перерисовка) примитивов;

• Lock (Зафиксировать) – блокировка. Слой может быть
заблокирован (закрытый замок), то есть изображенные
на нем примитивы остаются видимыми, но их нельзя
редактировать (стирать, перемещать и т.д.); по умолча�
нию слой разблокирован;

• Color (Цвет) – определяет цвет примитивов в данном слое;
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• Linetype (Тип линии) – по умолчанию устанавливается
Continuous (Сплошная), если в диалоговом окне отсут�
ствует необходимый тип линии, его можно загрузить,
щелкнув по клавише Load… (Загрузка...);

• Lineweight (Толщина линии) – устанавливается Default
(По умолчанию), требуемая толщина линии выбирается
из списка, который появляется при щелчке мышью по
строчке Default (По умолчанию);

• Plot Style (Стиль чертежа) – параметр связан с выбо�
ром стиля чертежа в зависимости от цвета примитива;

• Plot (Графика) – включает или отключает изображение
на данном слое при печати чертежа;

• Description (Пояснение) – создает пояснения к текуще�
му слою.

Для установки другого слоя в качестве текущего нужно
вначале щелкнуть мышью по имени этого слоя, а затем – по
кнопке Set Current (Текущий) диалогового окна. Для удале�
ния слоя нужно выбрать его имя и щелкнуть по кнопке Dele�
te (Удалить).

Упражнение 3.3. Создание слоев и перенос объектов

1. Открыть файл «Чертеж 2».
2. Создать новые слои и установить их параметры в соот�

ветствии с рис. 3.9а, после чего закрыть окно, нажав
кнопку ОК.

3. Перенести все осевые линии на слой Оси:
� выделить мышью все осевые линии (см. рис. 3.5);
� раскрыть список Layer Control (Управление слоем)

панели инструментов Layers (Слои), щелкнув
мышью на стрелке;

� щелкнуть мышью по надписи Оси;
� эту же операцию можно выполнить нажатием на кноп�

ку Make Object’s Layer Current (Сделать слой
объекта текущим) панели Layers (Слои) после выбора
осевых линий. В результате перечисленных действий
все осевые линии перенесутся на слой Оси, который
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станет текущим (в списке управления слоем появится
надпись Оси).

4. Перенести аналогичными операциями остальные элемен�
ты чертежа на свои слои: контурные линии – на слой
Контур, линии рамки – на слой Рамка.

5. Сохранить чертеж.

В AutoCAD 2007 можно изменять свойства объекта или
группы объектов в диалоговом окне Properties (Свойства).
Для этого нужно выделить объект, щелкнуть правой кнопкой
мыши по экрану и из контекстного меню выбрать опцию Pro�
perties (Свойства), после чего на экране появится диалоговое
окно (рис. 3.9б).

Рис. 3.9. Диалоговые окна Layer Properties Manager 

(Настройка свойств слоя) и Properties (Свойства)



4. ПРЕОБРАЗОВАНИЕ ЭЛЕМЕНТОВ
ЧЕРТЕЖА

В процессе выполнения чертежа ни один конструктор не
может обойтись без его корректировки. Рассмотрим команды
для редактирования чертежа в системе AutoCAD.

4.1. Выбор объектов

Для того чтобы отредактировать объект, его сначала
необходимо выбрать. Для одних команд редактирования (сти�
рание, копирование, перенос, поворот, зеркальное отображе�
ние, создание массива) можно вначале выбрать объект или
несколько объектов, после чего вызвать команду, или наобо�
рот. Однако для других команд (удлинение, обрезание, раз�
рывание, подобие, создание фасок и скруглений) выбор
объектов можно производить только после вызова команды в
ответ на приглашение Select objects: (Выберите объекты:).

Для одновременного выбора группы объектов в AutoCAD
предусмотрены различные способы. Всего существует
16 опций запроса Select objects: (Выберите объекты:) команд
редактирования. Рассмотрим три опции выбора группы объек�
тов, которые используются наиболее часто:

• Window (Рамка) – определяет область выбора объектов
при указании двух углов рамки прямоугольника по диа�
гонали, при этом будут выбраны те объекты, которые
полностью попали в рамку;

• Crossing (Пересечение) – определяет секущую рамку
при указании двух углов по диагонали, при этом будут
выбраны и те объекты, которые полностью попали в
рамку, и те, которые попали в рамку частично;

• ALL (Все) — выбирает все объекты чертежа.

Для задания опции выбора объектов нужно ввести пропис�
ные буквы ее названия в ответ на приглашение команды
Select objects: (Выберите объекты:).

В AutoCAD 2007 имеется функция Selection Preview
(Предварительный просмотр). Эта функция обеспечивает
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выделение объекта, над которым перемещается курсор. По
умолчанию объект выделяется утолщенной штриховой линией.

Практически все команды редактирования находятся в меню
Modify (Редактирование), а их пиктограммы – на панели
инструментов с таким же названием (рис. 4.1). Для вызова
команды редактирования нужно щелкнуть мышью по соответ�
ствующей пиктограмме панели инструментов Modify (Редак�
тирование).

Опишем команды редактирования в последовательности
расположения их пиктограмм на панели инструментов
(рис. 4.1), начиная со второй, так как команда Erase (Уда�
лить) была рассмотрена ранее.

4.2. Копирование и изменение местоположения
объектов

Эта группа команд позволяет переносить объекты, повора�
чивать их, копировать с переносом и зеркальным отображени�
ем, копировать объекты с упорядочением в определенные
структуры (массивы), создавать себе подобные, не меняя при
этом размеры и форму самих объектов.

Команда Сору

Команда Сору (Копировать) позволяет копировать
созданный объект или группу объектов. После вызова
команды на экране появляется квадратик прицела для
выбора объектов, а в командной строке – сообщение:

Command: copy (Команда: копировать);

Select objects:(Выберите объекты).
После окончания выбора объектов нужно нажать на клавишу

Enter или щелкнуть правой кнопкой мыши по экрану. В резуль�
тате появится следующий запрос команды:

Рис. 4.1. Панель инструментов Modify (Редактирование)



Specify base point or displacement, or [Multi�

ple]: (Определите базовую точку или перемещение или

[Несколько]:).
Следует указать точку, относительно которой предполага�

ется копирование объектов. После ввода базовой точки в
командной строке появится второй запрос:

Specify second point or displacement, or <use

first point as displacement> (Определите вторую

точку или <используйте первую точку для перемеще�

ния>).

Выбрав точку, необходимо нажать клавишу Enter.

Команда Mirror

Команда Mirror (Отражение) формирует зеркальное
отображение объекта. Эта команда часто используется
в машиностроительных чертежах. С ее помощью

можно получить целую деталь, используя половину или даже
четверть построенной детали. После запуска команды и выбо�
ра объектов система запрашивает первую и вторую точки оси
отражения – оси симметрии. Вводить можно любые две
точки, принадлежащие оси. После ввода точек команда
выдаст запрос:

Delete source objects [Yes/No]<N>: (Удаление

исходных объектов [Да/Нет]<Н>:).

По умолчанию (при нажатии клавиши Enter) исходные
объекты не удаляются. Для удаления исходных объектов
нужно ввести Y.

Команда Offset

Команда Offset (Отступ) используется для создания
прямолинейных и криволинейных подобных отрезков,
смещенных по нормали на фиксированное расстояние.
После запуска команда выдаст запрос:

Specify offset distance or [Through] < Through >:

(Определите величину отступа или [Точка] <Точка>).

Если в ответ на этот запрос ввести величину смещения, то
система ответит:
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Select object to offset or <exit>: (Выберите

объект для подобия или <выход>).

Нужно выбрать один из объектов, щелкнув по нему
мышью. После первого щелчка по объекту появится следую�
щий запрос:

Specify point on side to offset: (Определите

точку со стороны отступа:).

В ответ на этот запрос нужно указать мышью, в какую сто�
рону относительно объекта будет создаваться ему подобный.
Далее нажать клавишу Enter для выхода из команды.

Команда Array

Команда Array (Массив) позволяет копировать выбран�
ные объекты и располагать их в форме прямоугольно�
го или кругового массива. После запуска команды и
выбора объектов в командной строке появится запрос:

Enter the type array [Rectangular/Polar] <R>:

(Ведите тип массива [Прямоугольный/Круговой] <П>:).

Если ввести Rectangular (Прямоугольный), то команда
выдаст следующие запросы:

Enter the number of rows (–) < 1 >:(Введите число

строк (–) <1>:);

Enter the number of columns (III) < 1 >:(Введи�

те число столбцов (III) <1>:);

Enter the distance between or unit cell (–): (Вве�

дите расстояние между строками или размер ячейки (–).

В ответ на последний запрос можно задать размер ячейки
двумя точками противоположных вершин прямоугольника
(рамкой), определив тем самым разрядку строк и столбцов в
массиве.

Для построения кругового массива нужно ввести Polar (Кру�
говой). В ответ на запрос команды Enter the type array
[Rectangular/Polar] <P>: (Введите тип массива [Пря�

моугольный/Круговой] <К>:) последуют очередные запросы:
Specify center point of array: (Определите цен�

тральную точку массива:);

Enter the number of items in the array: (Введи�

те число элементов в массиве:);
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Specify the angle to fill (+ =ccw, – =cw) <360>:

(Определите угол заполнения (+ =ccw, – =cw) <360>:).

На последний запрос нужно ввести значение угла между
первым и последним элементами массива относительно цен�
тральной точки. Положительное значение угла заполнения
соответствует направлению против часовой стрелки, отрица�
тельное значение – направлению по часовой стрелке.

Последний запрос будет таким:
Rotate arrayed objects? [Yes/No]<Y>:(Поворачи�

вать объекты массива? [Да/Нет] <Д>).

При ответе Yes (Да) объекты поворачиваются при копиро�
вании относительно своей базовой точки. Для отрезка базовой
точкой является одна из конечных точек, для окружности –
центральная точка.

Команда Move

Команда Move (Перемещение) обеспечивает перемеще�
ние объекта или группы объектов. Процесс переноса
объектов похож на процесс копирования. После вызо�
ва команды и выбора объектов команда выдаст запрос:

Specify base point or displacement: (Определите

базовую точку или перемещение:).

После задания базовой точки последует очередной запрос:
Specify second point or displacement, or <use

first point as displacementx (Определите вторую

точку или перемещение или используйте первую точку

для перемещения).

В ответ на запрос нужно задать новое положение базовой точки
или вектор перемещения относительно первой базовой точки.

Команда Rotate

Команда Rotate (Поворот) позволяет поворачивать
объект или набор объектов вокруг базовой точки, опре�
деляемой в процессе диалога команды. После вызова
команды и выбора объектов команда выдает следую�
щие запросы:

Specify base point: (Определите базовую точку:);
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Specify rotation angle or [Reference]: (Опреде�

лите угол поворота или [Ссылка]).

В ответ на последний запрос можно указать угол поворота,
введя его в командную строку, или выбрать опцию Reference
(Ссылка). Опция Reference определяет угол относительно
существующего угла. При этом выдаются следующие запросы:

Specify the Reference angle <0>: (Определите ссы�

лаемый угол <0>:);

Specify the new angle:(Определите новый угол:).

В ответ на первый запрос нужно ввести угол, определяю�
щий текущее положение объекта, а в ответ на второй запрос –
угол, определяющий новое положение объекта.

4.3. Корректировка размеров объектов

Эта группа команд позволяет изменять размеры объектов,
масштабируя их целиком, сжимать или растягивать группы
объектов с изменением их формы, менять размер объекта
переносом конечной точки (для отрезков).

Команда Scale

Команда Scale (Масштаб) обеспечивает изменение раз�
мера существующих объектов. После вызова команды,
выбора объектов и задания базовой точки, относитель�

но которой будет происходить масштабирование, команда
выдает следующий запрос:

Specify scale factor or [Reference]: (Определите

коэффициент масштабирования или [Ссылка]:).

В ответ нужно ввести число, на которое будут умножаться
все размеры выбранных объектов, или выбрать опцию Refe�
rence (Ссылка) для определения коэффициента масштабиро�
вания с применением существующих объектов.

Команда Stretch

Команда Stretch (Растянуть) позволяет вытягивать
или сжимать часть изображения с изменением ее
формы, сохраняя при этом связь с остальной (неизмен�
ной) частью рисунка.



После вызова команды в ответ на запрос Select objects:
(Выберите объекты) нужно ввести латинскую букву C,
после чего выбрать объекты секущей рамкой. На следующий
запрос команды нужно указать базовую точку, после чего
мышью определить новое положение выбранных (пересечен�
ных и находящихся внутри рамки) объектов.

Команда Trim

Команда Trim (Обрезать) позволяет стереть часть
объекта точно по режущей кромке. Режущей кромкой
могут служить все рассмотренные выше примитивы,
а также штриховка и текст. После запуска команды

в ответ на запрос Select objects: (Выберите объекты:)
нужно выбрать объекты – режущие кромки.

После этого последует запрос:
Select object to trim or [Fence/Crossing/Proj�

ect/Edge/eRase/Undo/] (Выберите объект, который

нужно обрезать, или [Линия/Секущая/Проекция/Кром�

ка/уДалить/ Отмена]:).

В ответ на запрос нужно указать ту часть объекта, которая
должна быть удалена.

Команда Extend

Команда Extend (Продолжить) удлиняет объекты до
указанной граничной кромки. В качестве граничной
кромки может быть отрезок, дуга или полилиния.

Структура этой команды повторяет структуру команды
Trim (Обрезать). В процессе диалога вначале выбираются те
объекты, которые являются граничными кромками, а затем те,
которые удлиняются.

4.4. Конструирование объектов

Эта группа команд позволяет вносить конструктивные
изменения в объект: создавать фаски и сопряжения, разры�
вать объекты.

Глава 4. Преобразование элементов чертежа 49



Команда Break at Point

Команда Break at Point (Разорвать в точке) осущест�
вляет разрыв объекта в указанной точке. После запу�
ска команды и выбора объекта появляется следующий
запрос:

Specify first break point: (Определите первую

точку]:).

В ответ на этот запрос нужно указать точку разрыва на
объекте при помощи мыши.

Команда Break

Команда Break (Разрыв) позволяет осуществить раз�
рыв объекта на части без стирания или со стиранием
части примитива (линии, полилинии, сплайна, дуги,

окружности). После запуска команды и выбора объекта
появляется следующий запрос:

Specify second break point or [First point]:

(Определите вторую точку или [Первая точка]:).

В ответ на этот запрос нужно указать вторую точку на
объекте при помощи мыши. Первой точкой разрыва по умол�
чанию является точка, в которой находился прицел мыши при
выборе объекта (выбор должен быть прямым). Если в каче�
стве первой точки должна быть другая точка, то нужно в
ответ на первый запрос выбрать опцию First point (Первая
точка), после чего вновь последует запрос о выборе второй
точки:

Specify second break point: (Определите вторую

точку).

В результате происходит стирание части объекта между
первой и второй точками. Из окружности стирается дуга от
первой до второй точки в направлении против часовой стрелки.

Команда Join

Команда Join (Соединить) по своему действию проти�
воположна команде Break (Разрыв) и позволяет устра�
нить разрыв на прямой, дуге, а также объединить при�
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мыкающие друг к другу сплайны. После запуска команды и
выбора объекта появляется следующий запрос:

Select objects to join to source: (Выберите

объект для соединения к исходному:).

В ответ на это указываете присоединяемый объект.

Команда Explode

Команда Explode (Расчленить) позволяет расчленить
объект на составные части. Например, после расчлене�
ния треугольник будет состоять из трех отдельных

отрезков. После запуска команды появляется запрос о выборе
объекта для расчленения.

Команда Chamfer

Команда Chamfer (Фаска) создает фаски на углах,
образованных двумя пересекающимися прямыми. По
умолчанию команда срезает угол и строит новый отре�

зок (фаску) по линии среза. При этом концы фаски определяют�
ся или длиной катетов фаски, или длиной одного катета и углом
наклона фаски к первой выбранной прямой.

После запуска команда выдает сообщение о размерах кате�
тов фаски, которые были установлены ранее и формирует
запрос:

Select first line or [Undo/Polyline/Distance/An�

gle/Trim/mEthod/Multiple] (Выберите первую прямую

или [Отмена/Полилиния/Катет/Угол/Обрежь/Ме�

тод/Многократно]:).

Если установленные ранее значения катетов фаски подхо�
дят для ее формирования, то нужно выбрать одну из прямых,
а затем на очередной запрос Select second line: (Введи�
те вторую линию) указать на вторую.

В результате сформируется фаска, которая подрежет пер�
вую и вторую выбранные прямые. Как правило, создание
фаски происходит в два этапа. При первом запуске команды
устанавливаются требуемые параметры фаски. В ответ на пер�
вый запрос выбирается одна из двух опций: опция Distance
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(Катет) – для формирования фаски по двум катетам или опция
Angle (Угол) – для формирования фаски по катету и углу.

Если для формирования фаски выбрана опция Angle (Угол),
то команда будет поочередно выдавать следующие запросы:

Specify chamfer length on the first line <   >:

(Определите длину катета фаски для первой линии <  >:);

Specify chamfer angle on the first line <   >:

(Определите угол фаски относительно первой линии <  >:).

После установки требуемых параметров фаски система
выдаст приглашение на ввод команды. При повторном запу�
ске команда сформирует сообщение об установленных параме�
трах. Если требуется сохранить исходные отрезки после соз�
дания фаски, нужно вначале выбрать опцию Trim (Обрезать),
установив в ней значение No Trim (He обрезать), а только
затем приступить к созданию фаски.

Команда Fillet

Команда Fillet (Скругление) осуществляет сопряжение
двух отрезков, дуг, окружностей или линейных сег�
ментов полилинии. Процесс сопряжения аналогичен

процессу создания фаски. При первом запуске команды уста�
навливается нужный радиус сопряжения, а при повторном
запуске выбираются два сопрягаемых объекта.

Для установки радиуса нужно в ответ на первый запрос
команды Select first object or [Undo/Polyline/Radi�
us/Trim/Multiple] (Выберите первый объект или [Отме�

на/Полилиния/Радиус/Обрежь/Многократно]) выбрать
опцию Radius (Радиус), после чего ввести требуемое число.

Упражнение 4.1. Редактирование чертежа

1. Изменить фрагменты «Чертежа 2» в соответствии с
рис. 4.2, используя инструменты для редактирования.

2. Открыть файл «Чертеж 2» и сохранить его под именем
«Чертеж 3».

3. Построить зеркальное отображение перпендикуляра с
помощью команды Mirror (Отражение) в соответствии с
рис. 4.3. Для этого необходимо:
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� вызвать команду Mirror (Отражение);
� на запрос команды Select objects (Выберите

объекты) указать прямую 1;
� на запрос команды Specify first point of mir�

ror line (Определите первую точку линии

oтражения) указать на точку 2 параллелограмма;
� на запрос команды Specify second point of mir�

ror line (Определите вторую точку линии

отражения) указать на точку 3 параллелограмма;
� на запрос Delete source objects [Yes/No] <N>

(Удаление исходных объектов [Да/ Нет] <Н>:)

нажать клавишу Enter.
4. Переместить изображения гайки ближе к правому краю

чертежа:
� вызвать команду Move (Перемещение);
� на запрос команды Specify base point or dis�

placement (Определите базовую точку или

перемещение:) указать точку 1 (центр окружности);
� на запрос Specify second point or displacement, or <use

first point as displacement> (Определите вторую точку

Рис. 4.4. Перемещение изображения гайки



или перемещение или используйте первую точку для
перемещения) указать точку 2 на экране (рис. 4.4).

5. Создать дугу 2, подобную дуге 1, на расстоянии 5 мм от
нее (рис. 4.2), используя команду Offset (Отступ):
� вызвать команду Offset (Отступ);
� на запрос команды Specify offset distance or

[Through] < Through > (Определите величину

отступа или [Точка прохождения] <Точка про�

хождения>) ввести 5 и нажать клавишу Enter; на
запрос Select object to offset or <exit>

(Выберите объект для подобия или <выход>)

указать дугу 1;
� на запрос Specify point on side to offset

(Определите точку со стороны отступа) щел�
кнуть мышью по экрану справа от дуги 1.

Аналогично достроить линии 3 и 4, подобные внешнему
контуру (рис. 4.2).

6. Установить слой с именем Оси текущим и начертить на
нем окружность с радиусом 20 мм (осевая линия цен�
тров отверстий) с центром в точке 5 (рис. 4.2).

7. Установить слой Контур текущим и начертить на нем
окружность с радиусом 3 мм с центром в точке 6.

8. Построить еще три окружности радиусом 3 мм, исполь�
зуя команду Array (Массив) (при этом необходимо учи�
тывать положительное угловое направление):
� вызвать команду Array (Массив);
� на запрос Select object: (Определите объект)

указать на окружность и нажать клавишу Enter (или
через диалоговое окно команды Array (Массив));

� на запрос команды Enter the type array [Rec�
tangular/Polar] <R> (Введите тип массива

[Прямоугольный/Круговой] <П>:) ввести букву Р
(латинскую) и нажать клавишу Enter;

� на запрос Specify center point of array (Опре�
делите центральную точку массива:) указать
точку 5 (рис. 4.2);

� на запрос Enter the number of items in the
array (Введите число элементов в массиве:)

ввести цифру 4 и нажать клавишу Enter;
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� на запрос Specify the angle to fill (+ = ccw,
– = cw) <360> (Определите угол заполнения (+

= ccw, – = cw) <360>:) нажать клавишу Enter;
� на запрос Rotate arrayed objects? [Yes/No] <�

Y> (Поворачивать объекты массива? [Да/Нет]

<Д>:) нажать клавишу Enter.
9. Дополнить верхнюю проекцию детали (рис. 4.2) прямы�

ми 7 и 8. При построении прямой 7 использовать
объектную привязку к точке 9 и режим отслеживания.

10. Удалить линию 1 между прямыми 2 и 3 (рис. 4.5),
используя команду Trim (Обрезать):
� вызвать команду Trim (Обрезать);
� на запрос Select objects (Определите объекты)

указать прямую 2, а на повторный запрос Select
object: (Определите объект) указать прямую 3 и
нажать клавишу Enter;

� на запрос Select object to trim or [Fen�

ce/Crossing/Project/Edge/eRase/Undo/]

(Выберите объект, который нужно обрезать,

или [Линия/Секущая/Проекция/Кромка /уДа�

лить/Отмена]:) указать прямую 1 и нажать клави�
шу Enter.

11. Продолжить прямые 4 и 5 до прямой 6 (рис. 4.5),
используя команду Extend (Продолжить):
� вызвать команду Extend (Продолжить);
� па запрос Select objects (Выберите объекты)

указать прямую 6 и нажать Enter;
� на запрос Select object to Extend or [Fen�

ce/Crossing/Project/Edge/Undo/] (Выберите

Рис. 4.5. Удаление линии при использовании 

команды Trim (Обрезать)



объект, который нужно продолжить, или

[Линия/Секущая/Проекция/Кромка/Отмена]:)

указать прямую 4 и на повторный запрос Select
object to Extend or [Fence/Crossing/Proj�

ect/Edge/Undo/] (Выберите объект, который

нужно продолжить, или [Линия/Секущая/Проек�

ция/Кромка/Отмена]:) указать прямую 5 и нажать
клавишу Enter.

12. Скруглить нижний левый край детали дугой окружно�
сти радиусом 5 мм (рис. 4.6а), используя команду Fillet
(Округление), для этого:
� вызвать команду Fillet (Округление);
� на запрос команды Select first object or

[Undo/Polyline/Radius/Trim/Multiple] (Выбе�

рите первый объект или [Отмена/Полилиния/Ра�

диус/Обрежь/Многократно]) выбрать опцию Radi�
us (Радиус) вводом буквы R;

� на запрос команды Specify fillet Radius <  0>
(Определите радиус скругления <0>) ввести
цифру 5;

� на запрос команды Select tirst object or

[Undo/Polyline/Radius/Trim/Multiple] ]

(Выберите первый объект или [Отмена/Полили�

ния/Радиус/Обрежь/Многократно]) указать пря�
мую 1;

� на запрос Select second object (Выберите вто�
рой объект) указать прямую 2 и нажать клавишу
Enter.
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13. Выполнить фаску с катетом 2 мм по прямой 1 и под
углом 30° к ней (рис. 4.6,б), используя команду Cham�
fer (Фаска):
� вызвать команду Chamfer (Фаска);
� на запрос команды Select first line or

[Undo/Polyline/Distance/Angle/Trim/mEthod/

Multiple] (Выберите первую прямую или [Отме�

на/Полилиния/Катет/ Угол/Обрежь/Метод/Мно�

гократно]:) выбрать опцию Angle (Угол) буквой
A;

� на запрос команды Specify chamfer length on

the first line <0> (Определите длину перво�

го катета фаски <0>:) ввести цифру 2 и нажать
клавишу Enter;

� на запрос команды Specify chamfer angle on the
first line < > (Определите угол фаски отно�

сительно первой линии < >:) ввести число 30 и
нажать Enter;

� на запрос команды Select first line or [Poly�
line/Distance/Angle/Trim/Method] (Выберите

первую прямую или [Полилиния/Катет/Угол/Об�

режь/Метод]:) указать прямую 1;
� на запрос команды Select second line (Выбери�

те вторую прямую) указать прямую 2 и нажать
Enter;

� аналогично построить фаску для другого ребра и
верхней поверхности шестигранника.

14. Дополнить проекцию гайки линиями фаски – дугами
окружностей (рис. 4.7а), используя команду Arc (Дуга):
� вызвать команду Arc (Дуга), выбрать из выпадающе�

го меню Draw (Черчение) команду Arc ⇒ Start ⇒
End ⇒ Direction (Дуга ⇒ Начало ⇒ Конец ⇒ Напра�
вление);

� на запрос команды Specify start point of arc
or [Center] (Определите начальную точку дуги

или [Центр]) указать точку 1;
� на запрос команды Specify end point of arc

(Определите конечную точку дуги) указать точку
2 (привязка к точке 1);
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� на последний запрос команды Specify tangent

direction for the start point of arc (Опре�

делите направление касательной для начальной

точки дуги) потянуть мышью в направлении каса�
тельной к первой точке и щелкнуть мышью по экра�
ну (рис. 4.7а).

Аналогично достроить остальные дуги в нижней и верхней
части шестигранника.

15. Удалить нижнюю часть ребер гайки, используя команду
Break (Разрыв):
� вызвать команду Break (Разрыв);
� на запрос команды Select object (Определите

объект) указать на прямую 3 (рис. 4.7а);
� на запрос команды Specify second break point

or [First point] (Определите вторую точку

или [Первая точка]:) выбрать First point

(Первая точка) буквой F;
� на запрос команды Specify first break point

(Определите первую точку разрыва) указать
точку 2;

� на запрос Specify second break point (Опреде�
лите первую точку разрыва) указать на экране
точку за пределами прямой 3, например точку 4.

16. Построить окружность радиусом 7 мм с центром в точке
1 и окружность радиусом 9 мм с центром в той же точке.
Изменить толщину линии окружности 2, установив ее
0,15 мм (рис. 4.7б).
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17. Удалить часть окружности 2, используя команду Break
(Разрыв):
� вызвать команду Break (Разрыв);
� отключить режим объектной привязки OSNAP

(ОПРИВ) в строке состояния;
� на запрос команды Select object (Определите

объект) указать на точку 3 (рис. 4.7б);
� на запрос команды Specify second break point

or [First point] (Определите вторую точку

или [Первая точка]:) указать точку 4.
18. Сохранить чертеж.

4.5. Использование ручек редактирования

Редактировать объекты можно не только при помощи
команд редактирования. В системе AutoCAD есть способ
редактирования примитивов – с помощью ручек. Ручки –
маленькие квадратики, которые появляются в определяющих
точках объекта при его выборе.

Например, при выборе отрезка появляются его конечные и
средняя точки, а при выборе окружности центр и точки
четвертей окружности. Если щелкнуть на самой ручке, то она
становится активной (меняет цвет заполнения) и ее можно
использовать для преобразования объекта. Активная ручка
выделяется красным цветом. Для снятия выделения необходи�
мо щелкнуть по активной ручке еще раз.

Упражнение 4.2. Использование ручек редактирования

1. Открыть файл «Чертеж 3» и сохранить его под именем
«Чертеж 4». Если он был у вас открыт, но сейчас вы
работаете с другим чертежом, то его можно найти в
списке окна системного меню Window (Окно). В про�
тивном случае вы откроете через меню File ⇒ Open
(Файл ⇒ Открыть) версию Read only (Только для чте�
ния – то есть нельзя сохранять его под этим же именем).

2. Уменьшить радиус окружности (рис. 4.8а):
� щелкнуть по окружности 1;
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� щелкнуть по правой ручке и потянуть за нее мышью,
переместив окружность в положение 2.

3. Перенести прямые 1 и 2 в соответствие с размерами
окружности (рис. 4.8б):
� щелкнуть по прямой 1;
� включить режим ORTHO (ОРТО) и режим

OTRACK (ОСЛЕЖ) в строке состояния;
� щелкнуть по средней ручке и потянуть за нее

мышью, переместив прямую в нужное положение,
отслеживая при этом точку 3.

Аналогично переместить прямую 2.
4. Дополнить вид спереди мелкими отверстиями и соответ�

ствующими им осевыми линиями, используя опцию Сору
(Копировать) контекстного меню ручек (см. рис. 4.2):
� щелкнуть по прямой 10 (режим ORTHO (ОРТО) и

OTRACK (ОСЛЕЖ);
� щелкнуть по средней ручке, а затем щелкнуть правой

кнопкой мыши по экрану и из контекстного меню
ручек выбрать опцию Сору (Копировать);
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Рис. 4.8. Уменьшение радиуса окружности при помощи ручек и дополне<

ние чертежа новыми элементами



� потянуть за активную ручку мышью, переместив пря�
мую в нужное положение, отслеживая при этом
отверстия на нижней проекции.

5. Вычертить с использованием привязок проекции
призматического отверстия с размером 20х20 мм
согласно рис. 4.2.

6. Сохранить файл.

5. ОФОРМЛЕНИЕ ЧЕРТЕЖЕЙ

5.1. Выполнение штриховки

В машиностроительных чертежах штриховка применяется
для обозначения материала деталей при выполнении их разре�
зов и сечений. При выполнении штриховки заполняются обла�
сти, ограниченные замкнутым контуром, состоящим из отрез�
ков, дуг окружностей и т.д.

Для создания штриховки нужно щелкнуть по пиктограмме
Hatch (Штриховка) панели инструментов Draw (Черчение)
или вызвать команду из выпадающего меню с таким же име�
нем. После запуска команды на экране появляется диалоговое
окно штриховки по контуру Hatch and Gradient (Штриховка
и градиент) – рис. 5.1, в котором можно:

• выбрать нужную штриховку – окно списка Pattern
(Структура);

• определить часть чертежа, которую требуется заштрихо�
вать, – кнопки Pick Points (Выбрать точки) и Select
objects (Выделить объекты);

• задать параметры штриховки – окна списков Angle
(Угол) и Scale (Масштаб);

• предварительно просмотреть штриховку перед ее выво�
дом – кнопка Preview (Предварительный просмотр).

Градиентная заливка осуществляется аналогичным образом
через вкладку Gradient (Градиент) – выбирается количество
цветов и тип заливки.
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Определить область для штриховки (или заливки градиен�
том) можно двумя способами: или указать точку внутри обла�
сти (щелкнуть мышью), или выбрать объекты, которые огра�
ничивают область. В первом случае нужно нажать кнопку
Pick Points (Выбрать точки), a во втором – кнопку Select
objects (Выделить объекты). В палитре штриховок рядом с
окном списка можно устанавливать стили штриховки.

Удаляется штриховка так же, как и любой другой прими�
тив. Для редактирования штриховки нужно выбрать из выпа�
дающего меню опцию Hatch Edit (Редактирование штрихов�
ки). После выбора на экране появляется диалоговое окно
Hatch Edit, в котором устанавливаются новые требуемые
параметры.
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Рис. 5.1. Диалоговое окно Hatch and Gradient 
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Упражнение 5.1. Выполнение штриховки

1. Открыть файл «Чертеж 4» и сохранить его под именем
«Чертеж 5».

2. Заштриховать фигуру сечения на виде спереди, где
необходимо построить разрез по плоскости симметрии в
соответствии с рис. 5.2:
� перейти на слой Штриховка;
� вызвать команду штриховки, щелкнув по пиктограм�

ме Hatch (Штриховка);
� в диалоговом окне Hatch and Gradient (Штриховка и

градиент) щелкнуть по кнопке Pick Points (Выбрать
точки);

� щелкнуть четыре раза мышью внутри областей 1, 2,
3, 4, 5 и нажать клавишу Enter, границы областей
при этом выделятся. Если не все границы выделены,
тогда необходимо проверить их замкнутость с
помощью увеличения масштаба изображения на экране;

� в диалоговом окне установить параметры в соответ�
ствии с рис. 5.1;

� если штриховка не требует изменений, то нужно
опять вызвать диалоговое окно штриховки, нажав
клавишу Enter;

� выйти из диалогового окна, щелкнув мышью по кноп�
ке ОК.

3. Изменить шаг и наклон штриховки:

Рис. 5.2. Отредактированная штриховка фигур сечения



� вызвать через контекстное меню Hatch Edit (Редак�
тирование штриховки);

� щелкнуть мышью по штриховке;
� в диалоговом окне Hatch Edit установить: угол 90°,

масштаб 1,25;
� выйти из диалогового окна, щелкнув мышью по кноп�

ке ОК. После внесения изменений штриховка будет
соответствовать чертежу на рис. 5.2.

5.2. Нанесение размеров

Нанесение размеров является одним из наиболее трудоем�
ких этапов в процессе создания чертежа. Система AutoCAD
позволяет автоматизировать следующие операции [4]:

• нанесение размера, то есть автоматическое построение
всех элементов (выносных и размерных линий, стрелок,
размерного текста, полочек) в зависимости от типа размера;

• простановку последовательности связанных размеров:
цепочки размеров и размеров от базовой линии.

Размер обладает теми же свойствами, что и штриховка, а
именно: размер является блоком и ассоциативен, то есть изме�
няется при изменении формы детали. Команды простановки
размеров вызываются из выпадающего меню Dimension (Раз�
меры) или при помощи пиктограмм соответствующей панели
инструментов Dimension (рис. 5.3).

Простановка отдельных размеров

Команда Linear Dimension

Команда Linear Dimension (Линейный) позволяет соз�
дать горизонтальный, вертикальный или повернутый
размер. Размер можно задавать двумя способами:
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• последовательно указать точки начала выносных линий,
после чего указать точку расположения размерной
линии;

• выбрать объект (начальные точки выносных линий в
этом случае определятся автоматически), а затем ука�
зать точку расположения размерной линии.

Если после запуска команды на запрос Specify first

extension line origin or <seiect object> (Опреде�

лите начало первой выносной линии размера или

<выберите объект>:) указать на начало первой выносной
линии, то далее последует запрос о начале второй выносной
линии: Specify second extension line origin: (Опре�
делите начало первой выносной линии размера).

После введения начальной точки второй выносной линии
появится приглашение: Specify dimension line location
or [Mtext/Text/Angle/Horizontal/Vertical/ Rota�

ted]:(Определите положение линии размера или

[МТекст/Текст/Угол/ Горизонтальный/Вертикаль�

ный/Повернутый]:).
В ответ нужно указать на экране точку, через которую

будет проходить размерная линия, или выбрать для внесения
изменений одну из перечисленных опций:

• в текст размера – опции MText (МТекст), Text (Текст),
Angle (Угол);

• в расположение размерной линии – опции Horizontal
(Горизонтальный), Vertical (Вертикальный), Rotated
(Повернутый).

Для введения в текст размера символов нужно набрать с
клавиатуры до или после размера следующие коды:

• %%с – для нанесения знака диаметра;
• %%d – для нанесения знака градуса;
• %%р – для нанесения знака допуска (плюс/минус)

(символы латинские и без пробелов).

Для простановки размера вторым способом, то есть по
выбору объекта, нужно на первый запрос команды Specify
first extension line origin or <select object>

(Определите начало первой выносной линии размера
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или <выберите объект>) нажать клавишу Enter, после чего
указать на объект. Далее последует запрос о расположении
размерной линии и выборе опций команды.

Команда Aligned Dimension

Команда Aligned Dimension (Выровненный размер)
позволяет наносить линейный размер с размерной
линией, параллельной объекту. Выровненный размер
создается аналогично горизонтальному и вертикальному.

Команда Arc Length

Команда Arc Length (Длина дуги) позволяет задать
длину дуг окружностей и дуговых сегментов полили�
ний. Размерное число автоматически сопровождается
символом дуги.

Команда Ordinate

Команда Ordinate (Ординатный) позволяет задать раз�
меры детали с одинаковой толщиной по координатным
осям абсцисс и ординат.

Команда Radius Dimension

Команда Radius Dimension (Радиальный размер)
позволяет построить размер радиуса окружности или
дуги. На запрос команды Select arc or circle:

(Выберите дугу или окружность:) нужно указать на
окружность или дугу. Размерное число автоматически сопро�
вождается символом радиуса.

Команда Jogged

Команда Jogged (Радиус с изломом) позволяет постро�
ить размер радиуса окружности или дуги с большим
радиусом, центр которых не может быть показан в его
действительном положении.
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Команда Diameter

Команда Diameter (Диаметральный размер) позволяет
построить размер диаметра окружности или дуги. Созда�
ется аналогично радиальному размеру. Размерное число
автоматически сопровождается символом диаметра.

Команда Angular Dimension

Команда Angular Dimension (Угловой размер) позво�
ляет нанести размер, показывающий угол между двумя
непараллельными линиями.

Команды Quick Leader, Center Mark

Команда Quick Leader (Быстрая выноска) позво�
ляет чертить выносную линию, команда Center
Mark (Маркер центра) позволяет создать метку
центра окружности или дуги.

Команда Tolerance

Команда Tolerance (Допуск) позволяет наносить на
чертежи обозначения допусков, отклонений формы и
расположения поверхностей.

Отрисовка группы размеров

Команда Baseline Dimension

Команда Baseline Dimension (Размер с основной лини�
ей) позволяет нанести последовательно группу разме�
ров от базовой линии (первой выносной линии пред�
ыдущего размера).

Команда Continue Dimension

Команда Continue Dimension (Продолженный размер)
позволяет продолжать размеры от второй выносной
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линии предыдущего размера. Создается аналогично размеру
от базовой линии.

Команда Quick Dimension

Команда Quick Dimension (Быстрый размер) позволяет
автоматизировать простановку группы размеров. В дан�
ном случае размеры проставляются цепочкой друг за

другом, после указания соответствующих поверхностей.

Редактирование размеров

Команда Dimension Edit

Команда Dimension Edit (Правка размера) позволяет
изменить (редактировать) текст и угол наклона вынос�
ных линий.

Команда Dimension Text Edit

Команда Dimension Text Edit (Правка текста размера)
позволяет изменить местоположение текста на размер�
ной линии и ориентацию текста.

Команда Dimension Update

Команда Dimension Update (Обновление размера)
позволяет переопределить параметры размера в соот�
ветствии с текущими установками размерного стиля.

Команда Dimension Style

Команда Dimension Style (Размерные стили) позволя�
ет задать стиль простановки размеров. После нажатия
появляется диалоговое окно Dimension Style Manager
(Менеджер стилей размеров).

Размер, как и любой другой объект, можно редактировать
при помощи ручек, которые появляются при его выборе.
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Крайние ручки используются для смещения выносной линии,
а средняя – для смещения размерной линии и для перемеще�
ния текста вдоль нее.

5.3. Изменение размерного стиля

При загрузке системы устанавливается стиль ISO�25, опре�
деляемый набором параметров размера (расстоянием между
размерными линиями, размещением текста, размером текста и
стрелок, шрифтом текста и т.д.). Инструмент Dimension Style
(Стиль размера) позволяет вызвать диалоговое окно Dimen�
sion Style Manager (Менеджер стилей размеров) (рис.5.4) и
внести изменения в существующий стиль для простановки
размеров в соответствии с ГОСТ 2.307�68 [5,6].

Для внесения изменений в стиль размера нужно щелкнуть
мышью по кнопке Modify... (Изменить...), в результате чего
появится диалоговое окно Modify Dimension Style: ISO�25
(Заменить текущий стиль: ISO�25).

На странице Symbol and Arrows (Символы и стрелки) –
рис. 5.5 – устанавливаются параметры выносных и размер�
ных линий, а также параметры стрелок.

Рис. 5.4. Менеджер стилей размеров
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На странице Text (Текст) – рис. 5.6 – устанавливаются
параметры размерного текста (стиль текста, высота текста,
размещение текста над/под, внутри/вне размерной линии...).

Опции закладки Fit (Расположение) управляют способом
размещения текста, когда он не помещается между выносны�
ми линиями, и способом размещения размерной линии (между
выносными линиями или вне них).

Опции закладки Primary units (Основные единицы) – рис.
5.7 – управляют установкой формата единиц, округлением
вычисленного размера и масштабом размеров.

Упражнение 5.2. Простановка размеров

Нанести размеры в соответствии с рис. 5.8.

1. Открыть файл «Чертеж 5» и сохранить его под именем
«Чертеж 6».

2. Удалить с чертежа все изображения, кроме изображе)
ний детали.

3. Установить параметры размеров в соответствии с ГОСТ
2.307�68:

Рис. 5.7. Страница Primary Units (Основные единицы)



� при помощи инструмента Dimension Style (Стиль
размера) вызвать диалоговое окно Dimension Style
Manager (Менеджер стилей размеров) и щелкнуть по
кнопке Modify... (Изменить...) – рис. 5.4;

� открыть поочередно при помощи закладок страницы
и установить в них опции в соответствии с рис.
5.5–5.7 (высота стрелок, стиль, высота и выравнива�
ние текста, шрифт ISOCPEUR, Italic) после чего
щелкнуть на кнопке OK.

� закрыть диалоговое окно Dimension Style Manager
(Менеджер стилей размеров).

4. Перейти на слой Размеры.
5. Нанести вертикальный габаритный размер на виде спе�

реди (рис. 5.8):
� вызвать команду Linear Dimension (Линейный);
� на запрос команды Specify first extension line

origin or <select object> (Определите нача�
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ло первой выносной линии размера или <выбе�

рите объект>) указать на точку 1;
� на запрос команды Specify second extension

line origin: (Определите начало второй

выносной линии размера:) указать на точку 2;
� на запрос Specify dimension line location or

[MText/Text/Angle/Horizontal/ Vertical/ Rota�

ted]: (Определите положение линии размера или

[МТекст/Текст/Угол /Горизонтальный/Верти�

кальный/Повернутый]:) указать на экране любую
точку, через которую пройдет размерная линия 3.

6. Аналогично проставить остальные линейные размеры.
7. Нанести размер диаметра осевой линии, на которой рас�

положены центры четырех отверстий:
� вызвать команду Linear Dimension (Линейный);
� на запрос команды Specify first extension line

origin or <select object> (Определите нача�

ло первой выносной линии размера или <выбе�

рите объект>) указать на точку 4;
� на запрос команды Specify second extension

line origin: (Определите начало второй

выносной линии размера:) указать на точку 5;
� на запрос команды Specify dimension line loca�

tion or [MText/Text/Angle/Horizontal/ Ver�

tical/ Rotated]: (Определите положение линии

размера или [Мтекст/Tекст/Угол /Горизон�

тальный/Вертикальный/ Повернутый]:) из кон�
текстного меню (щелчок правой кнопкой мыши по
экрану) выбрать опцию MText (МТекст);

� ввести с клавиатуры без пробелов %%с40 (или
выбрать из окна редактора под кнопкой Simbol) и
нажать клавишу Enter;

� указать на экране точку, через которую пройдет раз�
мерная линия.

Перед введением знаков %%с не забудьте перейти на
латинскую раскладку клавиатуры.

8. Нанести размер радиуса внешней дуги:
� вызвать команду Radius Dimension (Радиальный

размер);
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� на запрос команды Select arc or circle; (Выбе�
рите дугу или окружность) указать на точку 6;

� на запрос команды Specify dimension line loca�
tion or [MText/Text/Angle]: (Определите поло�

жение линии размера или [Мтекст/Tекст/Угол])

указать на точку 7.
9. Аналогично нанести размер радиуса внутренней дуги.
10. Нанести размер диаметра для четырех отверстий диаме�

тром 6 мм:
� вызвать команду Diameter (Диаметральный размер); 
� на запрос команды Select arc or circle: (Выбе�

рите дугу или окружность) указать на точку 8;
� на запрос команды Specify dimension line loca�

tion or [MText/Text/Angle]: (Определите поло�

жение линии размера или [МТекст/Текст/Угол])

из контекстного меню (щелчок правой кнопкой мыши
по экрану) выбрать опцию MText (МТекст);

� в появившемся окне редактора набрать: (на русской
раскладке) 4 отв., (в латинской раскладке) %%с6 и
нажать клавишу Enter;

� протянуть маркер до точки 9 и щелкнуть мышью.
11. Повернуть все изображение на 90° (рис. 5.9) с помощью

команды Rotate (Повернуть).
12. Отредактировать размеры, которые накладываются на

контуры изображений.
13. С помощью команды Movie (Перемещение) располо�

жить изображение в центре поля чертежа.
14. Изменить габаритный размер детали в пределах

130–150 мм, «поджав» или «растянув» изображение
верхней части:
� вызвать команду Stretch (Растянуть), используя

соответствующий инструмент панели инструментов
Modify (Изменение);

� на запрос команды Select object: (Выберите

объект:) ввести с клавиатуры (латинская расклад�
ка) букву С, затем выделить с помощью рамки растя�
гиваемую часть изображения (верхняя часть изобра�
жения на рис. 5.9) и нажать клавишу Enter;
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� на запрос Specify base point of displacement:
(Определите базовую точку перемещения:) ука�
зать на любую точку, например на точку 1 (рис. 5.8);

� на запрос Specify second point of displace�
ment: (Определите вторую точку перемещения:)

потянуть мышью изображение вверх и, когда габа�
ритный размер станет равным 130–150 мм, щелкнуть
мышью.

При изменении формы объекта размеры автоматически
принимают соответствующие значения.

15. Сохранить чертеж.

Рис. 5.9. Повернутый чертеж



5.4. Текстовые вставки

Создание текста

Для включения в чертеж однострочной текстовой информа�
ции в AutoCAD используется команда Text (Текст). Вызов
этой команды происходит по следующим опциям: Draw ⇒ Text
⇒ Single Line Text (Черчение ⇒ Текст ⇒ Текстовая строка).

Чтобы ввести многострочный текст, следует использовать
команду MText (МТекст), для вызова которой нужно выбрать
Draw ⇒ Text ⇒ Multiline Text (Черчение ⇒ Текст ⇒ Мно�
гострочный) или использовать инструмент Multiline Text
(Многострочный) панели инструментов Draw (Черчение).

После вызова команды Multiline Text (Многострочный) в
командной строке появятся запросы:

Specify first corner: (Определите первый угол:);
Specify the other corner or [Height/Justify/Line

spacing/Rotation/Style/Width]: Определите противо�

положный угол или [Высота/Выравнивание/Межстрочный

интервал/Поворот /Стиль/Ширина].

Если в ответ на первый запрос указать на экране одну
точку прямоугольной рамки текста, а в ответ на второй запрос
ввести противоположную точку по диагонали, то на экране
появится диалоговое окно Text Formatting (Форматирование
текста) – рис. 5.10, в котором выполняются ввод текста и
установка его параметров.

Диалоговое окно Text Formatting (Форматирование тек�
ста) позволяет:

• задавать шрифт, высоту и формат символов, а также
включать в текст специальные символы;

Глава 5. Оформление чертежей 77

Рис. 5.10. Диалоговое окно Text Formatting 

(Форматирование текста)



• выбирать или задавать текстовый стиль, ширину
параграфа, поворот текста и его выравнивание;

• задавать расстояние между строками текста;
• находить и производить замену текста.

Изменение свойств текста производится только после выде�
ления редактируемой части текста. После ввода текста и
выхода из диалогового окна можно редактировать ширину
параграфа, растягивая или сжимая окно ввода текста при
помощи ручек.

Создание нового текстового стиля

При загрузке системы по умолчанию установлен опреде�
ленный стиль текста Standard, в котором установлен шрифт
Txt. Для выполнения надписей на чертеже лучше использо�
вать шрифт ISOCPEUR, который в большей степени соответ�
ствует ГОСТ 2.304�68 [6,7]. Если надписей на чертеже много,
то каждый раз менять шрифт в диалоговом окне текстового
редактора неудобно. Лучше создать новый текстовый стиль с
требуемым шрифтом и пользоваться им.

Новый стиль создается в диалоговом окне Text Style
(Стиль текста) и вызывается командой Format ⇒ Text Style...
(Формат ⇒ Стиль текста...). Имя нового стиля, например
stile 1, задается в окне New Text Style (Новый стиль текста),
появляющемся при нажатии кнопки New... (Создать…). В диа�
логовом окно Text Style (Стиль текста) в поле списка Style
Name (Имя стиля) устанавливается стиль stile 1, a в поле
списка Font Name (Шрифт) выбирается шрифт ISOCPEUR.

Упражнение 5.3. Текстовые вставки

1. Открыть файл «Чертеж 6» и сохранить его под именем
«Чертеж 7».

2. Поставить символ «*» у габаритного размера 150
(рис. 5.11).
� перейти на слой Текст;
� вызвать команду Text (Текст), выбрав Draw ⇒ Text ⇒

Single Line Text (Черчение ⇒ Текст ⇒ Текстовая строка);
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Рис. 5.11. Чертеж детали «Плита» на формате A4
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� на запрос команды Specify start point of text
or [Justify\Style]: (Определите начальный

угол текста или [Выравнивание\Стиль]) указать
точку над размерным числом;

� на запрос команды Specify height <5>: (Опре�
делите высоту <5>:) набрать высоту 5 мм и
нажать клавишу Enter;

� на запрос команды Specify rotation angle of

text <0>: (Определите угол вращения текст

<0>:) нажать Enter;
� ввести с клавиатуры символ «*» и дважды нажать Enter.

3. Ввести в чертеж текст «* Размер для справки», располо�
жив его над основной надписью (рис. 5.11):
� вызвать команду MText (МТекст), щелкнув по пик�

тограмме Multiline Text (Многострочный текст)
панели инструментов Draw (Черчение);

� на запрос команды Specify first corner: (Определите пер�
вый угол:) внести нижнюю левую точку рамки текста,
щелкнув мышью по экрану над основной надписью;

� на запрос команды Specify the other corner or
[Height/Justify/Line spacing/Rotatioin Sty�

le/Width]: (Определите противоположный угол

или [Высота/Выравнивания /Межстрочный

интервал/Поворот/Стиль/Ширина]:) ввести проти�
воположную по диагонали точку рамки текста;

� в диалоговом окне Text Formatting (Форматирова�
ние текста) – рис. 5.10 – выбрать шрифт
ISOCPEUR с курсивом, высоту текста установить
равной 5 и набрать соответствующий текст.

4. Начертить недостающие линии основной надписи по
ГОСТ 2.104�68 (чертить на слое Рамка) и заполнить ее
поля в соответствии с рис. 5.11 (заполнять поля на слое
Текст).

5. Сохранить Чертеж.

5.5. Вывод графической информации на печать

Вывод графической информации на печать осуществляется
при помощи команды File ⇒ Plot... (Файл ⇒ Печать...) или



щелчком мыши на пиктограмме Plot (Печать) (изображение
принтера) на системной панели инструментов. Команда File
⇒ Plot... (Файл ⇒ Печать...) открывает диалоговое окно Plot
(Печать) – рис. 5.12, в котором производится выбор печатаю�
щего устройства и установка параметров чертежа (масштаб,
расположение, ориентация).

6. МЕТОДИКА СОЗДАНИЯ ЧЕРТЕЖА

Необходимо отметить, что методика по вычерчиванию раз�
личных графических изображений, рассмотренная в предыду�
щих упражнениях, не является единственно возможной.
Построение того или иного чертежа зависит и от конфигура�
ции графических составляющих, от степени сложности черте�
жа, от подготовленности конструктора к работе в автоматизи�
рованной среде. Можно дать лишь общие рекомендации по
созданию чертежей в среде AutoCAD.
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Рис. 5.12. Диалоговое окно Plot (Печать)
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6.1. Рекомендации по созданию чертежей

1. Создать шаблон и использовать его в дальнейшем для
получения, например, чертежей формата А4, A3. При изго�
товлении шаблона произвести необходимые установки:
� задать пределы чертежа и единицы измерения;
� создать слои для вычерчивания на них различных

компонентов чертежа и установить для каждого слоя
требуемый тип, толщину и цвет линий;

� произвести настройку опций для простановки размеров;
� создать текстовый стиль для выполнения надписей на

чертеже;
� вычертить рамку и основную надпись;
� установить режим вывода на экран координатной

сетки.
2. Выполнять непосредственно чертеж, используя методику,

приближенную к ручному способу создания чертежа (здесь
у каждого конструктора может быть свой «почерк»).

6.2. Выполнение чертежа

Для реализации вышеприведенных рекомендаций можно
использовать различные способы. Рассмотрим один из спосо�
бов на примере вычерчивания детали «Корпус», изображен�
ной на рис. 6.1 [8].

Выбор варианта индивидуального графического задания
на рис.6.5–6.14 осуществляется по сумме двух последних
цифр номера зачетной книжки студента.

Индивидуальное графическое задание состоит из следую�
щих пунктов:

• построить по двум изображениям детали третье изобра�
жение с рациональными разрезами на формате A3;

• построить линии пересечения и перехода поверхностей
методом вспомогательных секущих плоскостей (линии
перехода проведены условно и на них поставлены знаки
вопроса);

• проставить размеры и заполнить основную надпись.



Перед тем как приступить к работе, необходимо определить
основные геометрические тела, из которых образована деталь.
Также следует определить пары пересекающихся между собой
поверхностей. Нужно построить характерные точки линий
перехода. Промежуточные точки необходимо определить спо�
собом вспомогательных секущих плоскостей. После постро�
ения линий перехода на всех трех изображениях проставить
размеры, распределив их рационально между видами.
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Рис. 6.1. Исходный вариант задания
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6.3. Поэтапное выполнение чертежа корпусной
детали

Упражнение 6.1. Построение чертежа корпусной детали

1. Построение третьего вида на основе исходного варианта
(рис. 6.1):
� открываем файл «Чертеж 7» и сохраняем его под

именем «Чертеж 8», изменив размеры формата (вме�
сто A4 создаем A3 с рамкой и основной надписью);

� проводим оси проекций, поделив поле чертежа на
четыре равные части; биссектрису проводим с помо�
щью полярного способа задания в относительных
координатах (на слое Оси);

� проводим ось симметрии для трех видов, пропорцио�
нально поделив пополам четверти поля чертежа;

� с помощью привязок Endpoint (Конец), Midpoint
(Середина), Center (Центр) и Intersection (Пересече�
ние) строим окружность оснований цилиндров на
виде сверху, а потом остальные проекции на виде
спереди и слева, используя инструмент Offset
(Отступ) (слой Контур);

� проводим осевую линию усеченного конуса в верхней
части детали и строим его проекции на трех видах,
используя инструмент Offset (Отступ) и привязку
Tangent (Касательная) (для вида сверху);

� строим окружность на виде сверху, на которой рас�
полагаются центры цилиндрических отверстий на
основании детали, и создаем отверстия, используя
инструмент Array (Массив) в полярном режиме.

2. Построение линий пересечения поверхностей (линии со
знаком вопроса на рис. 6.1):
� определяем точки пересечения усеченного конуса с

цилиндром с помощью метода вспомогательных секу�
щих плоскостей (фронтально�проецирующих), стро�
им эти точки на левой половине вида спереди и на
виде слева (рис. 6.2);



� после построения необходимого количества точек сое�
диняем их плавной кривой с помощью инструмента
Spline (Сплайн) и удаляем вспомогательные линии.

3. Построение разреза на видах спереди и сверху
(рис. 6.3):
� строим разрез на правой половине вида спереди

согласно варианту задания;
� определяем опорную точку пересечения цилиндриче�

ского отверстия внутри усеченного конуса на виде
спереди со сквозным цилиндрическим отверстием
внутри детали;

� определяем опорную точку пересечения цилиндрическо�
го отверстия в основании детали с внутренним отверсти�
ем в виде усеченного конуса в разрезе вида спереди;

� определяем граничные точки проекции цилиндриче�
ского отверстия (по осевой линии) во внутренней
части основания (упрощенно в виде эллипса);
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Рис. 6.2. Построение трех видов и линий пересечения
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� соединяем построенные точки пересечения плавной
кривой (в трех местах, где были знаки вопроса) с
помощью инструмента Spline (Сплайн), удаляем
вспомогательные линии.

4. Построение заданного горизонтального разреза на виде
сверху и сквозного призматического отверстия на всех
изображениях:
� строим горизонтальный разрез на виде сверху по

секущей плоскости А�А;
� строим, согласно заданным размерам, проекции сквозно�

го призматического отверстия на видах спереди и слева;
� удаляем вспомогательные построения;
� все контурные линии переносим на слой Контур, осе�

вые – на слой Оси.
5. Штриховка фигур сечения:

� выбираем слой Штриховка;
� с помощью инструмента Hatch (Штриховка), соглас�

но установкам параметров на рис. 5.1, заштриховы�
ваем фигуры сечения на изображениях, проверив их
замкнутость;

� указываем положение секущей плоскости А�А и нано�
сим обозначение разреза (слой Текст).

6. Простановка размеров:
� выбираем слой Размеры;
� с помощью инструмента Dimension Style (Стиль раз�

мера) устанавливаем параметры согласно
рис.5.5–5.7;

� с помощью инструмента Dimension (Размер) проста�
вляем размеры, согласно рис. 6.4.

7. Заполнение основной надписи. Выполняем эту опера�
цию в слое Текст.

8. Сохраняем чертеж и выводим его на печать.
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Рис. 6.4. Нанесение штриховки и простановка размеров

Рис. 6.3. Построение разреза и линий пересечения
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Рис. 6.5. Варианты (0–1) индивидуального графического задания

6.4. Варианты индивидуальных графических
заданий
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Рис. 6.6. Варианты (2–3) индивидуального графического задания
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Рис. 6.7. Варианты (4–5) индивидуального графического задания



Глава 6. Методика создания чертежа 91

Рис. 6.8. Варианты (6–7) индивидуального 

графического задания
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Рис. 6.9. Варианты (8–9) индивидуального графического задания
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Рис. 6.10. Варианты (10–11) индивидуального 

графического задания
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Рис. 6.11. Варианты (12–13) индивидуального 

графического задания
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Рис. 6.12. Варианты (14–15) индивидуального 

графического задания
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Рис. 6.13. Варианты (16–17) индивидуального 

графического задания
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Рис. 6.14. Вариант (18) индивидуального 

графического задания



7. ТРЕХМЕРНОЕ МОДЕЛИРОВАНИЕ

Для создания трехмерных объектов в CAD�системах
используют три основных способа моделирования: каркасное,
поверхностное и твердотельное, каждый из которых позволя�
ет создавать реальные объекты с различной степенью реали�
стичности:

• Каркасное моделирование. В данной модели предста�
вляются только ребра объекта и его грани не определе�
ны, поэтому модель является прозрачной. Для карка�
сной модели понятие объема отсутствует.

• Поверхностное моделирование. В этой модели опреде�
ляются ребра и грани объекта, она обеспечивает более
точное описание по сравнению с каркасной моделью.
Модель является непрозрачной, передние грани пере�
крывают тыльные. Поверхностная модель имеет объем,
но массу она не учитывает, так как не учитывается тол�
щина стенок модели.

• Твердотельное моделирование. Эта модель позволяет
описывать объект наиболее реалистично. Она дает пол�
ную информацию о внешних гранях и ребрах объекта, а
также описывает его внутреннюю структуру. Твердо�
тельная модель имеет объем, массу и учитывает харак�
теристики материала.

Трехмерное моделирование обеспечивает следующие воз�
можности:

• просмотр модели из любой точки пространства;
• выполнение сечения модели;
• автоматическое построение двухмерных чертежей модели;
• получение реалистичного отображения модели;
• добавление характеристик материала и внешнего осве�

щения.

В AutoCAD есть команды для работы в трехмерном про�
странстве, с помощью которых можно осуществлять как моде�
лирование трехмерных объектов, так и присвоение материала,
установку освещения. В версии программы AutoCAD 2007
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имеется более удобный специальный интерфейс для трехмер�
ного моделирования [4].

7.1. Трехмерное рабочее пространство

После первого запуска программы (см. рис. 1.1) в диалого�
вом окне можно было выбрать интерфейс 3D Modeling (3М
моделирование). Но для переключения в этот режим при
последующих запусках можно воспользоваться командой
Tools ⇒ Workspase ⇒ 3D Modeling (Сервис ⇒ Рабочее про�
странство ⇒ 3М моделирование) или после выбора соответ�
ствующего режима на панели Workspase (Рабочее простран�
ство) под системной строкой выпадающих меню (рис. 7.1).

В режиме 3D Modeling (3М моделирование) рабочее окно
программы меняется. В AutoCAD 2007 появилась панель
Dashboard (Инструментальная панель), которая состоит из
следующих панелей управления (рис. 7.1, правая часть окна):

• 2D Make (2М построения), по умолчанию она скрыта;
• 3D Make (3М построения);

Рис. 7.1. Окно рабочего пространства 3D Modeling (3М моделирование)
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• 3D Navigate (3М навигация);
• Visual Styles (Стили визуализации);
• Light (Освещение);
• Materials (Материалы);
• Render (Тонирование).

Каждая из этих панелей отображается частично, для разво�
рачивания вниз необходимо нажать на значок продолжения –
двойной галочки. Для временного увеличения рабочего про�
странства во время просмотра трехмерной сцены можно
использовать команду View ⇒ Clean Screen (Вид ⇒ Очистить
экран). Рассмотрим режимы отображения трехмерных объек�
тов для просмотра.

7.2. Режимы отображения и просмотра

Для изменения внешнего вида поверхностных и твердо�
тельных моделей используется команда View ⇒ Visual Styles
(Вид ⇒ Визуальные стили) или панель Visual Styles (Визу�
альные стили) – рис. 7.2, а также одноименная панель в опи�
санной выше панели Dashboard (Инструментальная панель).
Для проверки режимов отображения и просмотра откройте
любой объект из системной папки c:\Program Files\AutoCAD
2007\Help\buildyourworld.

Опции Visual Styles (Визуальные стили) позволяют
выбрать следующие режимы просмотра трехмерных объектов:

• 2D Wireframe (2М каркас) – отображаются только
отрезки и кривые, показываются только ребра, опреде�
ляющие границы поверхностей;

Рис. 7.2. Панель инструментов и панель управления 

Visual Styles (Визуальные стили)



Глава 7. Трехмерное моделирование 101

• 3D Wireframe (3М каркас) – отображаются трехмерные
модели в каркасном виде;

• 3D Hidden (3М скрытие) – скрываются невидимые
ребра модели;

• Realistic (Реалистичный) – заливает поверхность цве�
том объекта или типом материала (рис.7.1);

• Conсeptual (Концептуальный) – заливает поверхности
полупрозрачным цветом объекта.

Для создания пользовательского стиля отображения
используется команда Visual Styles Manager (Диспетчер сти�
лей визуализации).

Для просмотра трехмерных объектов используются коман�
ды из меню View (Вид) или Dashboard (Инструментальная
панель) – рис. 7.3:

• 3D Views (3М виды);
• 3D Orbit (3М орбита);
• 3D Walk (3М прогулка);
• 3D Fly (3М полет);
• 3D Distance (3М дистанция);
• 3D Swivel (3М шарнир);
• Parallel Projection (Параллельная проекция);

Perspective Projection (Перспективная проекция).
На панели инструментов View (Вид) имеются следующие

двухмерные и трехмерные виды:

• Top (Вид сверху);
• Bottom (Вид снизу);
• Left (Вид слева);
• Right (Вид справа);
• Front (Вид спереди);

Рис. 7.3. Панели инструментов для просмотра



• Back (Вид сзади);
• SW Isometric (Ю�З изометрический);
• SE Isometric (Ю�В изометрический);
• NE Isometric (С�В изометрический);
• NW Isometric (С�З изометрический).

С помощью инструментов для отображения и просмотра в
AutoCAD можно выбрать наиболее подходящий вид и режим
просмотра разрабатываемой модели трехмерного объекта.

7.3. Каркасное и поверхностное моделирование

В AutoCAD команды для построения поверхностей нахо�
дятся в меню Drawodeling ⇒ Meshes (Черчение ⇒ Модели�
рование сетки), которые представлены на рис. 7.4. С помо�
щью этого меню можно построить следующие типы поверхно�
стей:

• 2D Solid (Плоская поверхность) – плоская поверх�
ность, заданная угловыми вершинами;

• 3D Face (Трехмерная грань) – поверхность, заданная
тремя или четырьмя прямолинейными ребрами;

• Edge (Кромки) – управляет видимостью ребер объектов
типа 3D Face (Трехмерная грань);

• 3D Mesh (3М сетка) – многоугольная сетка, заданная
вершинами;

• Revolved Mesh (Сетка вращения) – сетка, полученная
в результате вращения произвольного двухмерного кон�
тура вокруг оси;

Создаем чертежи на компьютере в AutoCAD 2007/2008102

Рис. 7.4. Команды для построения поверхностей
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• Tabulated Mesh (Сетка сдвига) – сетка, полученная в
результате выдавливания произвольного двухмерного
контура по заданному направлению вектора;

• Ruled Mesh (Сетка соединения) – сетка, построенная
между двумя прямыми или криволинейными ребрами
путем интерполяции;

• Edge Mesh (Сетка по кромкам) – сетка, построенная
между четырьмя ребрами путем интерполяции (поверх�
ность Кунса).

Рассмотрим в упражнениях применение команд по созда�
нию поверхностей.

Упражнение 7.1. Команда 3D Face (Трехмерная грань).
Пирамида пятигранная

1. Перейдите в режим трехмерного моделирования коман�
дой Tools ⇒ Workspase ⇒ 3D modeling (Сервис ⇒
Рабочее пространство ⇒ 3М моделирование) с метриче�
скими единицами измерения. Сохраните файл под име�
нем «Пирамида».

2. Построим отрезок прямой в виде высоты пирамиды и
основание – в виде пятиугольника:
� вызовите команду Line (Линия);
� задайте первую точку с координатами: 100, 100, 0;
� задайте конец отрезка с координатами: 100, 100, 100

и нажмите клавишу Enter;
� вызовите команду Polygon (Многоугольник);
� задайте 5 углов и радиус описанной окружности 50 мм,

в качестве центра укажите основание высоты пирамиды.
3. Результат построений в виде каркасной модели пирами�

ды представлен на рис. 7.5, слева, в режиме отображе�
ния Realistic (Реалистичный). Трехмерная модель пред�
ставляет собой совокупность ребер пирамиды. Для
построения граней пирамиды воспользуемся командой
3D Face (Трехмерная грань):
� выберите команду Draw ⇒ Modeling ⇒ Meshes ⇒

3D Face (Черчение ⇒ Моделирование ⇒ Сетки ⇒
Трехмерная грань);



� на запросы поочередно укажите вершины основания
пирамиды – пятиугольника, в результате основание
будет состоять из набора двух перекрывающихся
четырехугольных граней;

� далее аналогично постройте треугольные боковые
грани пирамиды и сохраните построения.

4. Результат построений в виде поверхностной модели
пирамиды представлен на рис. 7.5, справа, в режиме
отображения Realistic (Реалистичный).

Упражнение 7.2. Команда Revolved Mesh 
(Сетка вращения).
Ладья вращения

1. Удалите предыдущие построения и сохраните файл под
именем «Ладья». В этом упражнении мы создадим шах�
матную фигуру в виде ладьи (таким же образом можете
создать пешку или слона).

2. Для этого воспользуемся способом вращения, поэтому
необходимо построить ось и профиль вращения шахмат�
ной фигуры:

Создаем чертежи на компьютере в AutoCAD 2007/2008104

Рис. 7.5. Каркасная и поверхностная модели пирамиды
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� выполните команду View ⇒ 3D Views ⇒ Top (Вид ⇒
3М виды ⇒ Вид сверху) для перехода на вид сверху;

� с помощью инструмента Line (Линия) постройте
отрезок прямой линии в виде оси вращения;

� с помощью инструмента Spline (Сплайн) постройте
профиль для вращения (рис. 7.6, слева);

� перед тем как выполнить вращение, необходимо
отметить, что по системным установкам количество
сегментов при вращении по умолчанию будет соста�
влять 6, результат в таком случае будет не очень
реалистичным, поэтому увеличиваем количество сег�
ментов, вводя через командную строку поочередно:
SURFTAB1, Enter, 50; потом SURFTAB2, Enter,
50.

3. Выбираем команду Draw ⇒ Modeling ⇒ Meshes ⇒
Revolved Mesh (Черчение ⇒ Моделирование ⇒
Сетки ⇒ Сетка вращения):
� на запрос сначала указываем на профиль для враще�

ния, потом – на ось вращения;
� на запрос о начальном и конечном углах вращения

нажимаем клавишу Enter (так как угол вращения

Рис. 7.6. Профиль и поверхностная модель ладьи



оставляем от 0° до 360°, хотя можно вращать частич�
но) и сохраняем построения.

4. Результат построений в виде поверхностной модели
ладьи представлен на рис. 7.6, справа, в режиме отобра�
жения Realistic (Реалистичный).

Упражнение 7.3. Команда Tabulated Mesh 
(Сетка сдвига).
Рельсы сдвинутые

1. Удалите предыдущие построения и сохраните файл под
именем «Рельсы». В этом упражнении мы создадим
рельсы из таврового профиля методом сдвига.

2. Для применения метода сдвига необходимо создать зам�
кнутую или открытую кривую и вектор сдвига:
� выполните команду View ⇒ 3D Views ⇒ Front (Вид ⇒

3М виды ⇒ Вид спереди) для перехода на вид спереди;
� с помощью инструмента Poliline (Полилиния) по�

стройте тавровый профиль, как показано на рис.7.7,

Создаем чертежи на компьютере в AutoCAD 2007/2008106

Рис. 7.7. Исходные объекты для сдвига 

и поверхностная модель рельса
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вверху (можно строить профиль из любых геометри�
ческих примитивов в виде единого объекта);

� для построения вектора сдвига перейдите на вид сверху
с помощью команды View ⇒ 3D Views ⇒ Top (Вид ⇒
3М виды ⇒ Вид сверху) и постройте отрезок прямой
линии, потом перейдите на удобный трехмерный вид.

3. Выберите команду Draw ⇒ Modeling ⇒ Meshes ⇒ Tabu�
lated Mesh (Черчение ⇒ Моделирование ⇒ Сетки ⇒
Сетка сдвига):
� на запрос о контуре указываете на построенный про�

филь, затем на вектор сдвига – прямую.
4. Сохраните файл. Результат построений в виде поверх�

ностной модели рельса представлен на рис. 7.7, внизу,
в режиме отображения Conсeptual (Концептуальный).

Упражнение 7.4. Команда Ruled Mesh 
(Сетка соединения).
Крыло трансзвуковое

1. Удалите предыдущие построения и сохраните файл под
именем «Крыло». В этом упражнении мы создадим
модель линейчатой поверхности крыла (косого клина)
методом соединения.

2. Для применения метода соединения необходимо создать
два замкнутых контура, в качестве которых будем исполь�
зовать трансзвуковой (околозвуковой) профиль крыла:
� перейдите на вид спереди и постройте из сплайна

профиль (дозвуковой, сверх� или трансзвуковой) в
виде двух направляющих линейчатой поверхности
косого клина (на рис. 7.8, вверху, представлены
направляющие для дозвукового профиля);

� перейдите на вид сверху и отодвиньте вторую напра�
вляющую на необходимое расстояние (рис. 7.8) и
выберите удобный трехмерный вид;

� можно также учитывать угол закрутки косого клина.
3. Выберите команду Draw ⇒ Modeling ⇒ Meshes ⇒

Ruled Mesh (Черчение ⇒ Моделирование ⇒ Сетки ⇒
Сетка соединения):



� на запросы поочередно указываете на построенные
направляющие профили.

4. Сохраните файл. Результат построений в виде поверх�
ностной модели крыла представлен на рис. 7.8, внизу, в
режиме отображения Realistic (Реалистичный).

Упражнение 7.5. Команда Edge Mesh (Сетка по кромкам).
Ковер�самолет

1. Удалите предыдущие построения и сохраните файл под
именем «Ковер». В этом упражнении мы создадим
модель криволинейной поверхности в виде коврика мето�
дом создания сетки по кромкам (поверхность Кунса).

2. Для применения данного метода необходимо создать
четыре трехмерных ребра (кромки) произвольной
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Рис. 7.8. Направляющие и поверхностная 

модель крыла
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формы в виде замкнутого контура. Сначала построим
габаритный параллелепипед для поверхности коврика:
� на трехмерном виде постройте прямоугольник с

помощью инструмента Rectangle (Прямоугольник);
� с помощью инструмента Copy (Копирование) скопируй�

те прямоугольник на некоторую высоту и достройте
вертикальные ребра параллелепипеда (рис. 7.9, вверху);

� выберите инструмент Spline (Сплайн) и на каждой
боковой грани параллелепипеда постройте сплайн
произвольной формы по замкнутому контуру (рис.
7.9, вверху).

3. Выберите команду Draw ⇒ Modeling ⇒ Meshes ⇒ Edge
Mesh (Черчение ⇒ Моделирование ⇒ Сетки⇒ Сетка по
кромкам):

Рис. 7.9. Направляющие сплайны и поверхностная 

модель коврика



� для построения «ковра�самолета» на запросы пооче�
редно указываете на построенные сплайны.

4. Сохраните файл. Результат построений в виде поверх�
ностной модели коврика представлен на рис. 7.9, внизу,
в режиме отображения Realistic (Реалистичный).

Далее рассмотрим еще две команды создания трехмерных
объектов, которые появились в первых версиях AutoCAD.

Упражнение 7.6. Команды Elevation (Уровень) 
и Thickness (Толщина).
Треугольник эзотерический

1. Удалите предыдущие построения и сохраните файл под
именем «Треугольник». В этом упражнении мы созда�
дим трехмерные объекты командами примитивов.

2. Команда Elevation (Уровень) вызывается с помощью
командной строки и присутствует в свойствах объекта
некоторых плоских примитивов, она позволяет припод�
нять фигуру над горизонтальной поверхностью.

3. Команда Thickness (Толщина) вызывается через меню
Format ⇒ Thickness (Формат ⇒ Толщина), а также
присутствует в свойствах объекта плоских геометриче�
ских примитивов. Если задать некоторое значение пара�
метру Thickness, то все плоские примитивы будут стро�
иться в виде трехмерных выдавленных объектов.

4. На виде сверху постройте треугольник, две замкнутые
дуги окружности и две окружности в виде глаза и зрач�
ка, как изображено на рис. 7.10, слева:
� перейдите на трехмерный вид, выделите треугольник,

с помощью контекстного меню (под правой кнопкой)
вызовите диалоговое окно Properties (Свойства);

� в строке Thickness (Толщина) задайте значение 5, в
строке Elevation (Уровень) установите значение 10;

� выделите дуги поочередно, в диалоговом окне Pro�
perties в строке Thickness установите значение 10;

� выделите окружность радужной оболочки и зрачка; в
диалоговом окне Properties в строке Thickness устано�
вите значения 15 и 20 (можно задать свои параметры).
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5. Сохраните файл. Поверхностная модель эзотерического
треугольника представлена на рис. 7.10, справа, в режи�
ме отображения Realistic (Реалистичный).

В AutoCAD можно создавать примитивы трехмерных
поверхностей. Они представляют собой многоугольные сетки.
В версии AutoCAD 2007 команда по созданию трехмерных
примитивов по умолчанию в меню отсутствует. Для их созда�
ния необходимо ввести команду 3D в командную строку.

Упражнение 7.7. Команда 3D Surfaces (3М поверхности).
Примитивы поверхностные

1. Удалите имеющиеся построения и сохраните файл под
именем «Примитивы». В этом упражнении построим
поверхностные модели трехмерных примитивов.

2. Выберите трехмерный вид и наберите в командной стро�
ке – 3D (3М):
� на запрос Box/Cone/DIsh/DOme/Mesh/Pyramid/Sphe�

re/Torus/Wedge (Праллелепипед\Конус\Чаша\Ку�

пол\Сетка\Пирамида\Сфера\Тор\Клин) выберите
поочередно представленные опции по названию и
постройте эти трехмерные примитивы.

Рис. 7.10. Исходные примитивы и их 

поверхностная модель



3. Сохраните файл. Поверхностные примитивы предста�
влены на рис. 7.11 в режиме отображения Realistic
(Реалистичный).

Этим упражнением мы проиллюстрировали выполнение
команд трехмерного поверхностного моделирования, суще�
ствующие в графической системе AutoCAD 2007. Используя
эти команды, вы вполне можете, реализовать свои творческие
идеи и фантазии в области дизайна (промышленного или
транспортного). В следующем упражнении мы на основе опи�
санных выше команд будем заниматься концептуальным
дизайном летательного аппарата.

Упражнение 7.8. Самолет «Летучая мышь»

1. Удалите предыдущие построения и сохраните файл под
именем «Мышь». Для реализации творческой идеи по
созданию поверхностной модели самолета «Летучая
мышь» вначале необходимо анализировать имеющиеся
команды (их возможности), а также составные части
моделируемого объекта.

Создаем чертежи на компьютере в AutoCAD 2007/2008112

Рис. 7.11. Поверхностные примитивы
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2. Разобьем самолет на составные части (с учетом оси
симметрии по длине корпуса): верхняя и нижняя
поверхность корпуса, поверхность киля и поверхность
сопла.

3. Корпус самолета должен быть обтекаемым, для его соз�
дания воспользуемся методом Edge Mesh (Сетка по
кромкам) в виде поверхности Кунса. Хвостовую часть и
сопла создадим командой Ruled Mesh (Сетка соедине�
ния).

4. Начнем построение с создания габаритного параллеле�
пипеда обтекаемого корпуса аналогично упражнению
«Ковер�самолет»:
� на трехмерном виде постройте габаритный параллеле�

пипед (пропорции на ваше усмотрение);
� постройте сплайны на боковых гранях, для создания

треугольного силуэта верхней части корпуса переме�
стите одну из вершин внутрь параллелепипеда;

� для удобства можно редактировать вид и положение
сплайнов на соответствующих проекциях;

� для построения нижней части корпуса постройте
новый сплайн на боковой грани исходного параллеле�
пипеда вдоль фюзеляжа;

� с помощью инструмента Mirror (Зеркало) постройте
зеркальные копии сплайнов крыла, перенесите все
сплайны на новый слой;

Рис. 7.12. Исходные плоские фигуры поверхности самолета



� постройте исходные плоские фигуры для хвоста и
сопла в виде полилинии или сплайна, перенесите их
на новый слой;

� результат подготовительной работы по созданию
поверхности самолета в виде исходных плоских
сплайнов и полилиний представлен на рис. 7.12.

5. С помощью команды Edge Mesh (Сетка по кромкам)
постройте поочередно левые и правые части корпуса,
перенесите нижнюю и верхнюю поверхность корпуса на
отдельные слои.

6. На новом слое создайте хвостовую часть и сопла с помо�
щью команды Ruled Mesh (Сетка соединения). Резуль�
тат построений в трех прямоугольных двухмерных про�
екциях и в югозападной изометрии представлен на рис.
7.13. При необходимости можно редактировать исход�
ные фигуры для корректировки аэродинамических
свойств летательного аппарата.

7. На рис. 7.14 представлены визуализации тонированной
поверхностной модели самолета «Летучая мышь» во
время крейсерского полета и в заходе на цель. Силуэт
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Рис. 7.13. Трехмерная поверхностная модель 

самолета в проекциях
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Рис. 7.14. Тонированная поверхностная модель самолета 

«Летучая мышь»



улетающей летучей мыши вы можете увидеть на нижней
визуализации.

Следует отметить, что вопросы тонирования и визуализа

ции в рамках данного пособия не рассматриваются, эти темы
рекомендованы для самостоятельного освоения [9].

7.4. Твердотельное моделирование

В AutoCAD команды для создания твердотельных моделей
находятся в меню Draw ⇒ Modeling (Черчение ⇒ Моделиро�
вание), команды для их редактирования – в меню Modify ⇒
Solids Editing (Редактирование ⇒ Редактирование тел).
Также можно воспользоваться панелью управления 3D Make
(3М построения) панели Dashboard (Инструментальная
панель), которые представлены на рис.7.15.

Алгоритм создания твердотельных моделей в AutoCAD
основан:

• на создании трехмерных объектов на основе примитивов
или двухмерных форм с последующим их превращени�
ем в трехмерные модели;
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Рис. 7.15. Команды и панели для работы 

с твердотельными моделями
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• на преобразовании трехмерных моделей с помощью
команд редактирования тел.

Рассмотрим сначала способы создания твердотельных при�
митивов.

Упражнение 7.9. Примитивы твердотельные

1. Удалите имеющиеся построения и сохраните файл под
именем «Твердые тела». В этом упражнении мы постро�
им твердотельные модели трехмерных примитивов.

2. Для их построения можно использовать меню Draw ⇒
Modeling (Черчение ⇒ Моделирование) или панель
управления 3D Make (3М построения) инструменталь�
ной панели Dashboard (Инструментальная панель).

3. Выберите трехмерный вид и постройте трехмерные тела:
Polysolid (Политела), Box (Параллелепипед), Wedge
(Клин), Cone (Конус), Sphere (Сфера), Cylinder
(Цилиндр), Pyramid (Пирамида), Torus (Тор).

4. Сохраните файл. Твердотельные примитивы представле�
ны на рис. 7.16.

Рис. 7.16. Твердотельные примитивы



Рассмотрим далее методы создания твердотельных моделей
на основе двухмерных форм с использованием команд преоб�
разования.

Упражнение 7.10. Команда Extrude (Выдавливание).
Упаковка «Сердце»

1. Удалите предыдущие построения и сохраните файл под
именем «Сердце». В этом упражнении мы построим
твердотельную модель кондитерской (или косметиче�
ской) упаковки.

2. На виде сверху с помощью полилинии или сплайна
постройте замкнутую фигуру в виде контура сердца.
Скопируйте фигуру, перенесите на отдельный слой и
выключите слой, чтобы при необходимости можно было
к ней вернуться. Перейдите на трехмерный вид и выбе�
рите команду Draw ⇒ Modeling ⇒ Extrude (Черче�
ние ⇒Моделирование ⇒ Выдавливание):
� на запрос выбираете фигуру, далее задаете высоту

выдавливания, например, 40 (результат представлен
на рис.7.17, слева).

3. С помощью этой команды можно создать также угол
заострения. Для этого выберите копию фигуры или
отмените предыдущие действия:
� выберите команду Extrude (Выдавливание), на

запрос укажите фигуру;
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Рис. 7.17. Твердотельные модели, созданные 

методом Extrude (Выдавливание)
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� далее из меню командной строки выбираете метод
Taper angle (Угол заострения);

� задаете угол заострения 30 и высоту выдавливания
40. Результат представлен на рис. 7.17, справа.

4. На основе имеющейся двухмерной фигуры создадим
твердотельную модель упаковки с трехуровневым выда�
вливанием. Выберите команду Extrude (Выдавливание):
� на запрос укажите исходную фигуру, далее из меню

командной строки выбираете метод Taper angle
(Угол заострения);

� задаете угол заострения (–30) и высоту выдавлива�
ния 10;

� для дальнейших построений необходимо воспользо�
ваться командой редактирования тел Modify ⇒
Solids Editing ⇒ Extrude Faces (Редактирование ⇒
Редактирование тел ⇒ Выдавливание грани);

� на запрос указываете верхнюю грань построенной
модели, задаете высоту выдавливания 20, угол заос�
трения 0;

� повторяете команду Extrude Faces (Выдавливание
грани), задаете высоту выдавливания 10, угол заос�
трения 30.

5. Сохраните файл. Результат построений в виде тониро�
ванной твердотельной модели упаковки представлен на
рис.7.18.

Рис. 7.18. Тонированная твердотельная 

модель упаковки



Упражнение 7.11. Команда Revolve (Вращение).
Манжета и бокал с вином

1. Удалите предыдущие построения и сохраните файл под
именем «Манжета». В этом упражнении мы построим
твердотельные модели уплотнительной манжеты [10] и
бокала методом вращения.

2. На виде спереди с помощью полилинии (или сплайна)
постройте замкнутый профиль манжеты и ось вращения
в виде отрезка прямой линии, как представлено на
рис.7.19, слева. Скопируйте профиль и перенесите на
отдельный, затем выключенный, слой.

3. Перейдите на трехмерный вид и выберите команду
Draw ⇒ Modeling ⇒ Revolve (Черчение ⇒ Моделиро�
вание ⇒ Вращение);
� на запрос выбираете замкнутый профиль, далее зада�

ете ось вращения, указывая на начало и конец отрез�
ка прямой;

� задаете диапазон угла вращения 270° (по кругу 360°);
� результат представлен на рис. 7.19, справа, с выре�

зом четвертой части, в юго�восточной изометрии.
4. Сохраните построения. Необходимо отметить, что в

качестве оси вращения можно из меню командной стро�
ки выбрать соответствующие оси координат, тогда
одним профилем можно получить два разных объекта.

Создаем чертежи на компьютере в AutoCAD 2007/2008120

Рис. 7.20. Профиль вращения и твердотельные 

модели на его основе
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Рис. 7.19. Профиль вращения и твердотельная модель 

(с вырезом) манжеты

5. Для создания бокала необходимо на виде спереди
построить замкнутый профиль вращения из полилинии
или сплайна.

6. На рис. 7.20 представлены профиль для вращения и
твердотельные модели, созданные на его основе. В каче�
стве оси вращения в данном случае взяты вертикальные
и горизонтальные сегменты самого профиля. В резуль�
тате получается бокал и блюдо.

7. На рис. 7.21 представлена визуализация тонированной
модели бокала (с жидкостью, вином).

Рис. 7.21. Визуализация тонированной твердотельной 

модели бокала с вином



Упражнение 7.12. Команда Sweep (Изгиб).
Сверло искривленное

1. Удалите предыдущие построения и сохраните файл под
именем «Сверло». В этом упражнении мы построим
твердотельную модель сверла методом изгиба.

2. На виде спереди с помощью полилинии (или сплайна)
постройте замкнутый профиль для выдавливания свер�
ла и путь изгиба в виде отрезка прямой линии, как пред�
ставлено на рис. 7.22, слева.

3. Перейдите на трехмерный вид и выберите команду
Draw ⇒ Modeling ⇒ Sweep (Черчение ⇒ Моделирова�
ние ⇒ Изгиб):
� на запрос выбираете замкнутый профиль, далее для

реализации закручивания из меню командной строки
выбираете Twist (Закручивание);

� задаете угол закручивания 270°, потом указываете в
качестве пути на отрезок прямой и сохраняете
построения.

4. Результат построений в виде твердотельной модели
сверла представлен на рис. 7.22, в центре. В правой
части этого рисунка представлена твердотельная
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Рис. 7.22. Профиль для изгиба и твердотельные 

модели сверла
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модель искривленного сверла, полученного аналогичным
образом по криволинейному сплайну в виде пути изгиба.

Упражнение 7.13. Команда Loft (Лофтинг).
Статуэтка и ракета

1. Удалите предыдущие построения и сохраните файл под
именем «Статуэтка». В этом упражнении мы построим
твердотельную модель статуэтки методом лофтинга. Для
применения метода лофтинга необходимо создать путь
для лофтинга и сечения в виде плоских фигур.

2. На виде сверху с помощью двухмерных примитивов
(два шестиугольника, пять окружностей, три эллипса и
закругленный прямоугольник) постройте фигуры сече�
ния статуэтки (из одного центра), на виде спереди
постройте ось высоты. Далее переместите и расположи�
те их по высоте, как изображено на рис.7.23, слева.

3. Перейдите на трехмерный вид и выберите команду
Draw ⇒ Modeling ⇒ Loft (Черчение ⇒ Моделирова�
ние ⇒ Лофтинг):

Рис. 7.23. Плоские фигуры для лофтинга 

и твердотельная модель статуэтки



� на запрос поочередно выбираете фигуры сечения по
высоте;

� из диалогового окна Loft Setting (Режимы лофтинга)
выберите подходящий режим сглаживания и сохра�
ните построения.

4. Результат построений в виде твердотельной модели ста�
туэтки представлен на рис. 7.23, в центре.

5. На рис. 7.23, справа, представлены плоские сечения для
создания ракеты методом лофтинга. На рис. 7.24 пред�
ставлена визуализация тонированной модели ракеты,
созданной методом лофтинга, на фоне Земли.

В следующем упражнении мы создадим твердотельную
модель плиты на основе чертежа, выполненного нами ранее
(см. рис. 5.11). Для ее конструирования мы воспользуемся
командами теоретико�множественных операций, представлен�
ных в меню Modify ⇒ Solids Editing (Редактирование ⇒
Редактирование тел) и на панели управления 3D Make (3М
построения). К ним относятся команды Union (Объединение),
Subtract (Вычитание) и Intersect (Пересечение).
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Рис. 7.24. Визуализация тонированной 

твердотельной модели ракеты
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Упражнение 7.14. Команды Union (Объединение), 
Subtract (Вычитание), Intersect (Пересечение).
Конструирование плиты

1. Удалите предыдущие построения и сохраните файл под
именем «Плита». В этом упражнении мы сконструируем
твердотельную модель плиты методом выдавливания с
применением теоретико�множественных операций. Для
этого откройте файл «Чертеж 7», скопируйте вид слева
детали «Плита» (рис. 7.25, вверху) и перенесите в теку�
щий файл с трехмерным режимом.

2. На виде сверху расформируйте проекцию детали на три
части, перенеся каждую часть на отдельный слой (рис. 7.25,
внизу). Не забудьте замкнуть контур верхней площадки
(рис. 7.25, в центре).

3. Перейдите на трехмерный вид, выключите слои с верх�
ним контуром и отверстиями, выберите команду

Рис.7.25. Плоские контуры плиты для 

выдавливания



Draw ⇒ Modeling ⇒ Extrude (Черчение ⇒ Моделиро�
вание ⇒ Выдавливание):
� на запрос задаете высоту выдавливания 30 мм без

заострения согласно чертежу детали (см. рис. 5.11);
� включите слой с верхним контуром детали и выдави�

те его на высоту 35 мм;
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Рис. 7.26. Выдавливание основания 

плиты и отверстий

Рис. 7.27. Визуализация тонированной твердотельной 

модели детали «Плита»
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� для объединения двух тел выберите команду Modify ⇒
Solids Editing ⇒ Union (Редактирование ⇒ Редакти�
рование тел ⇒ Объединение). Результат представлен
на рис. 7.26, слева;

� включите слой с отверстиями и выдавите их также на
высоту 35 мм (рис. 7.26, справа).

4. Для сверления отверстий нам необходимо вычесть из
основания плиты созданные цилиндры и призму. Выбе�
рите команду Modify ⇒ Solids Editing ⇒ Subtract
(Редактирование ⇒ Редактирование тел ⇒ Вычитание):
� на запрос сначала указываете основание плиты, а

потом вычитаемые тела. Сохраните построения.
5. Результат построений в виде визуализации тонирован�

ной твердотельной модели плиты представлен на рис.
7.27.

Этим упражнением мы закончили описание основных спо�
собов твердотельного моделирования. Построение скругления
на нижней части корпуса плиты трудно реализуемо в програм�
ме AutoCAD, для этих целей более подходящим является
трехмерная система компании Autodesk Mechanical Desktop.

Рассмотренными методами твердотельного моделирования
вы получили еще более широкие возможности для реализации
своих творческих идей в области трехмерного моделирования,
в чем желаю вам успехов!

Подытоживая данную главу, рассмотрим для демонстрации
возможностей графической системы AutoCAD процесс созда�
ния трехмерной твердотельной модели самолета�амфибии Бе�
200, разработанной Таганрогским авиационным научно�техни�
ческим комплексом (ТАНТК) им. Бериева.

Упражнение 7.15. Моделирование самолета�амфибии Бе�200

1. В этом упражнении мы создадим трехмерную модель
самолета�амфибии методами твердотельного моделиро�
вания. Для этого потребуется некоторый исходный мате�
риал в виде габаритных чертежей и фотографий модели�
руемого объекта (рис. 7.28) [11].
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Рис. 7.28. Взлет самолета/амфибии Бе/200 с воды

2. Для конструирования разобьем самолет на составные
части: лодка (фюзеляж), крыло, киль, двигатели, стаби�
лизаторы и поплавки. При моделировании мы воспользу�
емся в основном методом лофтинга. Это по технологиче�
ским соображениям наиболее подходящий метод, использу�
емый как в самолетостроении, так и в судостроении. В каче�
стве плоских сечений будут использованы шпангоуты
лодки, от их количества будет зависеть точность модели.

3. Плоские сечения построим на основе сплайна и распре�
делим по длине лодки. Аналогичным способом построим
крыло и хвостовое оперение. По ходу желательно
исходные плоские формы копировать на отдельные слои
и создавать поэтапные резервные файлы для редактиро�
вания в дальнейшем. Двигатели и поплавки созданы
методом вращения из полилинии.

Совокупность исходных плоских форм для моделирования
с распределением их в пространстве представлены на рис. 7. 29.

На рис. 7.30 представлена твердотельная модель самолета�
амфибии в режиме отображения Realistic (Реалистичный).

На рис. 7.31 представлена визуализация сцены взлета
самолета�амфибии.
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Рис. 7.29. Исходные плоские формы для моделирования

Рис. 7.30. Твердотельная тонированная модель 

самолета/амфибии
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Рис. 7.31. Визуализация сцены взлета 

с воды самолета/амфибии
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ЗАКЛЮЧЕНИЕ

В данной книге были рассмотрены методики создания чер�
тежей и трехмерных моделей в графической системе AutoCAD
2007.

В первой главе было описано окно графической системы,
существующие меню и панели инструментов, системы коорди�
нат, вопросы создания и сохранения чертежей, а также
настройка параметров системы под конкретного пользователя.

Во второй и третьей главах были представлены графиче�
ские примитивы и их свойства, рассмотрены вопросы создания
слоев. Даны упражнения по построению рамки формата и чер�
тежа, изображения детали и шестигранной гайки.

В четвертой главе были описаны команды по редактированию
графических элементов чертежа с использованием их в упраж�
нениях. Были добавлены в изображения фаски, скругления,
массив в виде отверстий, были построены перпендикуляры,
параллельные и зеркальные отрезки прямых, операции удли�
нения, подрезки и разрыва.

В пятой главе была описана методика выполнения штри�
ховки фигур сечения, установки нового размерного стиля и
нанесения размеров, команды создания текстовых вставок и
вывода на печать графической информации.

В шестой главе была рассмотрена методика создания чер�
тежей, поэтапное выполнение чертежа корпусной детали,
представлены варианты индивидуальных графических зада�
ний по техническому черчению с построением линий пересече�
ния поверхностей.

В седьмой главе была рассмотрены возможности графиче�
ской системы AutoCAD в области трехмерного моделирова�
ния. Была показана настройка трехмерного рабочего про�
странства, описаны методы построения трехмерных объектов
в виде каркасных, поверхностных и твердотельных моделей.
По каждому методу в конкретных упражнениях были созда�
ны трехмерные объекты различного назначения.

Работа содержит также контрольные вопросы, список реко�
мендуемой учебной и методической литературы.

Необходимо отметить, что целью данного пособия не являлось
описание всех возможностей графической системы AutoCAD.



Данная работа предназначена для освоения графической
системы AutoCAD и ее возможностей по созданию чертежей и
трехмерных моделей с нуля в компактном виде. Применение
команд и инструментов проиллюстрировано поэтапными
упражнениями.

Для расширения возможностей трехмерного моделирова�
ния и автоматизации построения чертежей моделей рекомен�
дуется освоение трехмерной системы Mechanical Desktop.
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КОНТРОЛЬНЫЕ ВОПРОСЫ

1. Опишите назначение и возможности системы AutoCAD.
2. Какие выпадающие меню содержит строка системного

меню?
3. Какие основные виды контекстного меню вы знаете?
4. Какие панели инструментов существуют в AutoCAD?
5. В чем заключается настройка параметров рабочей среды?
6. Какие форматы чертежа предусмотрены ГОСТ 2.301�68?
7. В каких системах координат можно строить графиче�

ские примитивы в системе AutoCAD?
8. С помощью какой панели инструментов можно чертить

графические примитивы, и какие графические примити�
вы она содержит?

9. Что понимается под объектной привязкой?
10. Что такое слой и какие слои существуют на вашем чер�

теже «Корпус»?
11. Какие команды содержит панель инструментов Modify

(Редактирование)? Как они работают?
12. Какие команды корректировки размеров вы знаете?
13. Что понимается под редактированием примитивов с

помощью ручек?
14. С помощью какой команды осуществляется штриховка?
15. Какие инструменты содержит панель Dimension (Разме�

ры)?
16. Какие четыре типа размеров проставляются на чертеже

детали?
17. Как необходимо установить стиль простановки размеров?
18. Какие существуют три основных способа простановки

размеров на чертеже?
19. Какие существуют команды по созданию текста, и какой

шрифт рекомендуется для использования в текстовых
вставках?

20. Перечислите основные этапы построения чертежа, реко�
мендуемые в системе AutoCAD.

21. Перечислите основные элементы окна трехмерного рабо�
чего пространства графической системы AutoCAD.



22. Какие методы трехмерного моделирования существуют,
их преимущества и недостатки?

23. Какие режимы просмотра и отображения существуют в
графической системе AutoCAD?

24. Для чего предназначена и какие команды содержит
панель Dashboard (Инструментальная панель)?

25. Какие команды и методы поверхностного моделирова�
ния существуют в системе AutoCAD?

26. Проиллюстрируйте применение методов вращения и
сдвига для создания трехмерных объектов.

27. Проиллюстрируйте применение методов соединения и
поверхности Кунса для создания трехмерных объектов.

28. Что позволяют команды Elevation (Уровень) и Thic�
kness (Толщина)?

29. Какие поверхностные примитивы существуют в системе
AutoCAD?

30. Какие команды и методы твердотельного моделирования
существуют в системе AutoCAD?

31. Какие твердотельные примитивы существуют в системе
AutoCAD?

32. Проиллюстрируйте применение методов выдавливания и
вращения для создания трехмерных объектов.

33. Проиллюстрируйте применение методов изгиба и лоф�
тинга для создания трехмерных объектов.

34. Какие команды редактирования твердотельных моделей
существуют в системе AutoCAD?

35. Какие теоретико�множественные операции существуют в
системе AutoCAD?

36. Приведите основные этапы создания твердотельной
модели на примере корпусной детали.
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